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Introduction 
TurboCAD for AutoCAD Users 

If you are an AutoCAD user, then you are probably curious about how TurboCAD compares 

to AutoCAD. Here we look at some of the similarities and differences between AutoCAD and 

TurboCAD. 

What TurboCAD Offers the AutoCAD User 
TurboCAD offers the AutoCAD user many advantages, including DWG compatibility, better 

handle-based editing, a broader variety of object snaps, and an improved user interface. It 

offers features not found in AutoCAD, such as built-in raster-to-vector conversion, history for 

3D solid models, node editing, and constraint management. 

File Compatibility 

TurboCAD reads a variety of vector file formats, including many of the same files produced 

by AutoCAD: 

• AutoCAD DWG drawing format, up to and including 2019.

• Autodesk DXF drawing interchange format, up to and including 2019.

• Autodesk DWF drawing Web format.

• Spatial Technology SAT, the ASCII version of ACIS solid model files.

• 3D Studio surface models, and STL stereolithography fi les .

TurboCAD also reads files created by competitors, such as DGN (Bentley Systems), DCD 

(DesignCAD), and FCW (FastCAD for Windows). 

It supports a host of vector formats, such as IGES, STEP, Metastream, HPGL (Hewlett- 
Packard graphics language), VRML (virtual reality markup language), CGM (computer 

graphics metafile), and WMF (Windows metafile). 

In addition, TurboCAD can import AutoCAD drawings and symbols via the Windows Clip- 

board and as OLE objects. 



TurboCAD for AutoCAD 
Users

2 

2 

The TurboCAD User Interface 
Because of Windows, much of TurboCAD’s interface is the same as AutoCAD’s. You already 

know how to use the menu bar, toolbars, scroll bars, status bar, and so on. Here is an over- 

view of the TurboCAD Ribbon user interface with classic theme and its primary elements: 

Tools Menu Properties bar Ribbon Menu bar  Ruler 

Status bar Inspector bar Scroll bar 

TurboCAD’s user interface 

Coordinate bar 

If you don’t care for the interface or theme, select another one from Tools – Customize – 

Option – Styles and Themes, or create your own. 
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Repeating Commands 

As an AutoCAD user, you know that some commands, such as Point, repeat automatically, 

and that some don’t, such as Circle. To make non-repeating commands repeat, you need to 

employ the Multiple command or press the spacebar. 
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Visual Styles and rendering 

 

In TurboCAD, all drawing and editing commands repeat. More precisely, the current 

command remains in effect until you select a different one. Start with the Circle command, 

and TurboCAD continues drawing circles — until you choose another command. 

AutoCAD’s default command is Select; TurboCAD’s default command is Line. 

 

Local Menus 
Right-click the drawing to bring up a context-sensitive local menu (known as the cursor menu 

or shortcut menu in AutoCAD). The local menu is related to the current tool in use. It   

usually contains the Properties option to access the properties of the selected   object. 

 
  Select, Node edit  

Standard 3D viewpoints 

Workplane options 

 
 
 
 
 
 

TurboCAD’s local menu in node edit mode 

At the top of the local menu is a handy toolbar that lets you quickly select rendering modes 

(first row of icons), switch viewpoints (second row), and control workplanes (third row). 

 

Coordinate Bar 

The Coordinate bar displays the current 3D coordinates. To change the value of X, Y, or Z, 

press Shift+Tab to move the focus to the X field. The tiny boxes lock the related coordinate 

when an ‘x’ appears in them; this is the equivalent to using the. x, y, and. z point filters in 

AutoCAD. 
 

Locked value 

 
X coordinate  Current zoom level  

Current time 

(click to show the date) 

TurboCAD’s Coordinate bar 

TurboCAD displays coordinates in absolute, relative, and polar modes. To change quickly 

between modes, press Shift+A for absolute coordinates, Shift+R for relative, and Shift+P 

for polar display (distance and angle). 

The Coordinate bar can be used together with the Inspector bar to place objects in drawings 

— all by keyboard entry. 
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For example, you can draw precise lines with the Line command and the keyboard, as follows: 

Step 1: Press Shift+Tab to access the Coordinates bar, and then enter the x coordinate. 

Step 2: Press Tab to enter the y coordinate. 

Step 3: Press Enter to start drawing the line. 

Step 4: Press Tab to access the Inspector bar, and then enter the length. 

Step 5: Press Tab again to enter the   angle. 

Step 6: Press Enter to define the second   point. 

Editing with Select Cursor 

AutoCAD’s grips editing emphasizes stretching and moving; performing other editing 

functions, such as copying and rotating, requires pressing the spacebar or entering option 

letters. 

TurboCAD adds the rotate grip missing from AutoCAD. Use the Select cursor to stretch, 
scale, move, and rotate the selected object(s) through grips. (Speaking of stretching, circles 

can be stretched into ellipses, and vice versa.) 

Stretch (scale) 

Move 
(also, the center of 

rotation) 

Rotate 

Inspector Bar 

TurboCAD’s Select cursor stretches (scales), moves, and rotates objects 

TurboCAD’s Inspector bar is like AutoCAD’s Dynamic Input, but located near the status bar. 

For instance, when you begin drawing a circle, the Inspector bar displays the radius, diam- 

eter, and circumference. Click the padlock icon to lock the associated value; this is like 

AutoCAD’s point filters. 

The Inspector bar changes the fields and buttons it displays, depending on the object you 
are drawing. Illustrated below is the Inspector bar displayed when drawing circles. 

Cancel command 
Locked value 

Automatically add constraints 

Display object properties 

TurboCAD’s Inspector bar 

As you move the cursor, the values are updated continuously, unless locked. Press Tab to 

access the Inspector bar and enter new values. 
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On the right of the Inspector bar are three buttons. These toggle whether constraints are 

added automatically, the operation cancels, or the Properties dialog box displays. 

Palettes 
Both AutoCAD and TurboCAD offer palettes. You’ll find palettes in TurboCAD for blocks, 

command tools, lights, rendering materials, and more. TurboCAD’s Selection palette is like 

AutoCAD’s Properties palette, and the Design Director palette is like DesignCenter. 

TurboCAD has some palettes that are not found in AutoCAD, such as for reporting measure- 
ment information, viewing part trees, and recording macros. Similarly, AutoCAD has palettes 
not found in TurboCAD; the table below illustrates the similarities and differences. 

AutoCAD Palette Equivalent TurboCAD Palette 

Advanced Render Setup Environment 

Dashboard Tools 

DesignCenter (Folders) TC Explorer 

DesignCenter (Open Drawings) Design Director 

Lights Luminances 

Materials Materials 

Properties Selection Info 

QuickCalc Calculator/Variables 

Tool Palettes Blocks, Symbols 

Palettes not in TurboCAD 

dbConnect Substitute with Tools | Database 

External References Substitute with Insert | Create External References and Tools | Raster Images 

Info Substitute with Help | TurboCAD Help Topics 

Markup Set Substitute with File | Open, and then select “DWF” format 

Sheetset Sheet sets not supported by TurboCAD 

Visual Styles Substitute with View | Camera | Draft Render 

Palettes not in AutoCAD 

Substitute the Color dialog box Color 

Substitute the SolView command Drafting 

Substitute the Browser command Internet 

Handcode in Notepad Macro Recorder 

Substitute the Dist and Area commands Measurement Info 

Part trees not available in AutoCAD Part Tree 
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Illustrated below are three of TurboCAD’s 16 palettes. 

Left: TurboCAD’s Selection Info 

palette Center: DesignDirector 

palette Right: Environments 

palette 

Often, TurboCAD palettes do more than what a first glance 

might reveal. The Calculator palette, for instance, is more than a calculator: it is also used 

with TurboCAD’s Dimensional Constraint Engine to display the driving dimensions 

created in constrained drawings. Vari-ables can be modified in the Calculator with 

formulas that describe mathematical relation- ships between the dimensions. 
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How TurboCAD Differs from AutoCAD 
As mentioned, the primary difference you’ll notice between TurboCAD and AutoCAD is that 

all commands automatically repeat until you select another command. Some other crucial 

differences include the following. 

 

What’s Missing from TurboCAD 
As an AutoCAD user, you have come to expect a certain selection of commands. You might 

not, however, find a few of them in TurboCAD. In some cases, the commands have different 

names. For example, gradient fills aren’t applied with a Gradient command, but with 

TurboCAD’s Pen Brush property. AutoCAD uses visual styles to edit in 3D rendered mode; in 

TurboCAD, you would turn on Draft Render mode. In Appendix, we provide a comparison of 

many AutoCAD commands with their TurboCAD equivalent. 

Some AutoCAD features are completely missing from TurboCAD, such as sheetsets, DWF 
markup sets, and a few 3D solid modeling commands. 

On the other hand, TurboCAD contains commands lacking in AutoCAD. For example, 

TurboCAD can import DWF files as entities. AutoCAD isn’t able to draw a series of concentric 

circles as quickly as TurboCAD. Creating 2D views of 3D models with AutoCAD’s SolView 

command seems downright pre-historic compared to TurboCAD’s Drafting palette. And 

while AutoCAD illustrates a simple history of edited solid models, TurboCAD shows the 

complete part tree in the Part Tree palette. 

You may find some of TurboCAD’s commands to be oddly implemented. For example, there 

is a command that draws one line perpendicular to another. The AutoCAD user would 

wonder why a separate command is needed, instead of just using Perpendicular object snap. 

While TurboCAD does have a perpendicular snap mode, users may like the fact that lines can 

be drawn perpendicularly without having to turn on a snap mode. 

 

Jargon 
Many terms in TurboCAD are similar to AutoCAD, but there are some differences. You may 

have already noticed that TurboCAD uses the name “local menu” instead of shortcut menu 

or cursor menu. AutoCAD’s linetypes are TurboCAD’s “line patterns”; model space is 

“world” space. 

Whereas AutoCAD has most of its editing commands in the Modify menu, TurboCAD has 

them in the Edit and Modify menus. AutoCAD’s Draw menu is like TurboCAD’s Draw 

menu. In Appendix , we provide a brief AutoCAD-TurboCAD jargon dictionary. 

 

TurboCAD Drawing Commands 
The primary user interface difference is that TurboCAD commands cannot be typed in, as 

with AutoCAD. For this reason, TurboCAD tends to have more commands than AutoCAD, 

because each command is usually limited to fewer options. 
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For instance, AutoCAD has one command for drawing circles: its Circle command has five 

options for constructing circles by a variety of methods. In contrast, TurboCAD has eight 

circle commands, one for each primary construction method. 

              
 

Left: AutoCAD’s circle construction methods 
Right: TurboCAD’s circle construction methods 

 
 

AutoCAD Circle options Equivalent TurboCAD commands 
 

Center, Radius Center and point (enter radius on Inspector bar) 

Center, Diameter Center and point (enter diameter on Inspector bar) 

2 Points Double point 

3 Points Triple point 

Tan, Tan, Radius Tangent to Arc or Curve 

Tangent to Line 

Tan, Tan, Tan Tangent to 3 Arcs 

Tangent to Entities 
 

 

Because most TurboCAD commands provides options on the Inspector bar, this multiplies 

the number of ways that TurboCAD can draw circles, as listed by the table below. 

TurboCAD Circle command Inspector Bar options 
 

Center and Point (1) Radius, (2) Diameter, (3) Circumference 

Concentric (4) Radius, (5) Diameter, (6) Circumference 

Double Point (7) Radius, (8) Diameter, (9) Circumference, (10) Angle 

Tangent to Arc or Curve (11) Radius, (12) Diameter, (13) Circumference 

Tangent to Line (14) Radius, (15) Diameter, (16) Circumference 

Triple Point (17) none 

Tangent to 3 Arcs (18) none 

Tangent to Entities (19) Radius, (20) Diameter, (21) Circumference 
 

 
In general, TurboCAD provides more variations than does AutoCAD. There are more object 

snap modes, more ways to draw, and more ways to edit. 
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Many TurboCAD commands also display buttons on the Inspector bar, in place of the 

command prompts used by AutoCAD. These allow you to change parameters on-the-fly and 

access dialog boxes with even more options. Illustrated below are the Inspector bar buttons 

displayed by the Tools | Trace command. 
 

Size of raster images (in pixels) Curve recognition toggle Connect lines toggle 
 

Set trace color 

 

Finish the command 

Options (displays dialog box) 

Toggle preview mode 

Toggle "grab window" mode 

Buttons on the Inspector bar for the Trace command 

The Finish flag  is a common sight; click it to tell TurboCAD you’re done specifying 

options. 

 

Node Editing 
TurboCAD’s node editing is an enhancement over grips editing. It allows you to move, add, 

and remove nodes. Node editing is useful for converting objects, such as closing arcs into 

circles and dividing lines into multiple segments. 

To add or remove nodes, hold down the Ctrl key while performing the action: click where 
there is no node to add one; click on a node to remove it. Icons show which action is being 

performed — add or remove. The figure below shows a rectangle being edited by its nodes. 

A new local menu item “Highlight end points” (On/Off) has been added to “Edit” tool. The 

item is enabled if the selected graphic is non-closed and if vertex count > 2. 

 
 

Node editing cursor 

 

Removing a node 

 
 

 

Adding a node 

 

 
 

 

 

TurboCAD’s node editor 
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Most nodes are blue; the red and green ones show the start and endpoints of arcs, circles, 

and ellipses. 

TurboCAD’s green and red nodes indicate start and stop points 

.
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What’s Unique to TurboCAD

Mechanical Tools 

AutoCAD provides just few tools for creating mechanical drawings. There’s a block library of 

bolts, a user interface suitable for 3D modeling, and a weak history for editing solid models. 

In contrast, TurboCAD Pro Platinum includes significant tools for 2D and 3D mechanical 

models — in addition to the constraints noted above. 

The Parts Tree palette displays editable history trees of 3D operations, such as blends, 
Booleans, and shells. You can use it to apply and change chamfers and fillets; change the size 

and position of Boolean operations; and change the thickness and open faces of shelled   

solids. 

Facet deform changes the shapes of surface and solid faces. It either applies uniform 

pressure or specifies deformation points and constraints. 

TurboCAD deforming the faces of a 3D solid 
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Architectural Tools 
AutoCAD provides multilines for drawing walls, and dynamic blocks for placing doors, 

windows, and other symbols. Strictly speaking, Autodesk would rather you use their Revit 

architectural software, which is completely different from AutoCAD. 

TurboCAD Pro Platinum includes tools specific to architectural drafting: create and edit 

walls, add window and door openings, and design roofs. The walls are smart objects: 

intersections are automatically cleaned up, and openings are made for symbols that orient 

themselves automatically. 

Opening are represented twice, once each for 2D and 3D. Blocks inserted into openings are 

seen correctly in orthographic (floor plan) and isometric (3D) views. Roofs can be placed on 

any 3D object, not just walls. 

Window symbol Automatically 
mitered wall 

Wall opening 

You access these tools through the Tools | Architecture menu. From there, you can draw 

walls, roofs, openings, windows, and doors. The Tools | FloorPlan Print Space Maker menu 

imports 3D architectural drawings made in FloorPlan. 

Pricing 
TurboCAD offers both Permanent License pricing and Annual Subscription pricing, whereas 

AutoCAD is only available on a Subscription basis..



TurboCAD for AutoCAD 
Users 

14 

 

 

 

When You Need More Help 
If you need more help, refer to the on-line documentation available in TurboCAD. Select 
TurboCAD Help Topics from the Help menu. 

In Appendix, at the back of this manual, we provide a list of AutoCAD’s commands, along 

with the equivalent in TurboCAD, and an explanation of differences. Throughout the text, 

we provide a translation of jargon unique to TurboCAD. The AutoCAD jargon is listed in 

parentheses following “a.k.a.” (short for “also known as”). For example: 

line style (a.k.a. linetype) 

Appendix provides a TurboCAD-AutoCAD dictionary, listing TurboCAD jargon in alpha- 
betical order with the AutoCAD translation. 
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Setting Up Drawings 
Lesson 1: Scale, Units, Layers, and Save 

 
 

To understand better how TurboCAD compares with AutoCAD, we invite you to sit through a 

parallel design session. On the left-hand page, AutoCAD’s actions are described; on the right 

side, TurboCAD’s. We’ll work with the most recent releases available at the time of writing 

this book: AutoCAD 2019 and TurboCAD Platinum 2019 Version 25. 

Because you are most familiar with AutoCAD, we recommend you work through this tutorial 
with TurboCAD running on your computer. As you work through the lessons on the right- 

hand “TurboCAD” pages, keep an eye on the left-hand “AutoCAD” pages. That will help 

alert you to the similarities and differences between the two CAD programs. 

 

About the Tutorials 

This book includes two tutorials, one for 2D drafting and one for 3D modeling. 

For the 2D tutorial, you will be creating an engineering-view drawing of a mechanical part 

small enough to fit a standard A-size sheet of paper. This drawing lets you practice placing 

lines, construction lines, arcs, dimensions, and applying fillets. The drawing is sketched on 

the next page. 
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Hand sketch of 2D drawing exercise 

Lesson 1: Scale, Units, Layers, and Save 

This chapter contains the first lesson. In it, you learn how to set up the drawing in preparation 

for creating the mechanical part. Setting up new drawings includes these steps: 

• Starting the CAD software.

• Using the Page Setup Wizard to set the drawing scale and other parameters.

• Creating the layer names.

• Setting the snap and grid spacing.

• Naming the drawing.

Lesson 2: Drawing, Editing, and Block Creation 

In lesson 2, you begin to draw the mechanical part by placing objects, such as rectangles, 

lines, circles, and arcs. You also learn how to create and place blocks. 
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Lesson 3: Dimensioning, Paper Space, Text, and Plotting 

In lesson 3, you apply the finishing touches to the 2D mechanical drawing: 

• Dimensioning using horizontal, vertical, and radial dimensions.

• Switching to paper space and inserting a title block.

• Placing and modifying text.

• Plotting the drawing with the Page Setup and Print commands.

Lesson 4: Modeling in Three Dimensions 

In lesson 4, you create the same part as a 3D solid model. The model lets you practice 

extruding objects to 3D solids, and then editing them. 

Rendering of 3D modeling exercise 
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Starting AutoCAD 
To prepare the drawing, you use the Advanced Setup Wizard to set drawing parameters. 

To start AutoCAD, double-click its icon. (Alternatively, click the Windows Start button, and 

then select Programs, AutoCAD 2019, and AutoCAD 2019 again.) Notice that AutoCAD 
appears. 

Both AutoCAD and TurboCAD start up by displaying one or more dialog boxes. User can 

choose to don’t show these dialogue boxes at start option for  

By Default, Ribbon UI is set as default workspace. 

On start, you will land on Start Tab which holds Open Files, Open a Sheet Set & 
Example/last opened files. 

You can start by just clicking on Start Drawing button. 

For your help, you can use Menu bar from Classic UI in Ribbon UI: 

 
 

 

AutoCAD: Advanced Setup Wizard 
Use the Advanced Setup Wizard to help set the parameters for this new drawing. 

1. You can access the wizard by selecting New from the File menu — provided that the 

Startup system variable is set to 1. Notice that AutoCAD displays the Create New 

Drawing dialog box. 

a. Click the Use a Wizard button. 

b. Select Advanced Setup, then click OK. 

AutoCAD displays the Units step of the Advanced Setup dialog box. 
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AutoCAD’s Create New Drawing dialog box 
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Starting TurboCAD 
To prepare the drawing, you use the Page Setup Wizard to set drawing parameters. 

To start TurboCAD, double-click its icon. (Alternatively, click the Windows Start button, and 

then select go to programs, IMSI TurboCAD 2019, and then TurboCAD 2019.) Notice that 

TurboCAD appears. 

Both AutoCAD and TurboCAD start up by displaying one or more dialog boxes. User can 

choose to don’t show these dialogue boxes at start from TurboCAD settings. By default, these 

dialogue boxes don’t show. 

If these appear, then take the following actions: 

• TurboCAD WorkSpace Style dialog box — select “e.g. Ribbon Style” 

• New TurboCAD 2019 Drawing Dialogue – Choose “New from Scratch” 

This dialogue box also has options of New from Template, Page Setup Wizard, Open 
Drawing, Open Last Edited, Cancel 

 

TurboCAD: Page Setup Wizard 
Use the Page Setup Wizard to help set the parameters for this new drawing. 

1. You access the wizard from the File menu: select Page Setup Wizard. 

Notice that TurboCAD displays the Wizard dialog box. 

 

TurboCAD’s Wizard dialog box 
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2. Setup Units from Drawing Units window found at Format | Units and select the display 
format of units. 

a. Select Engineering units and a precision of 2 decimals places (looks like   0’0.00"). 

3. Now to you need to setup Angle on same window. 

Accept the default of Decimal Degrees and 0 decimal places by clicking Next. Leave the 
Clockwise option as unchecked. 

 

 
 

AutoCAD’s Drawing Unit / Angle dialog box 
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2. Page 1 selects the display format of units. Select the default of English units. Click   Next. 

3. TurboCAD displays the Wizard - Page 2 dialog box for specifying the drawing units. 

a. Select Engineering (ft-in). 

b. Accept the default Decimal Precision of 2 places by clicking Next. 

 
TurboCAD’s unit’s setup dialog box 

4. TurboCAD displays the dialog box for Page 3. 

a. Under Paper Size Options, select Choose a Specific Paper Size and then ensure that 

“ANSI A Size” is showing in the droplist. For Paper Orientation, select Landscape. 
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TurboCAD’s paper size dialog box 
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5. Now you need to set Angle Direction. Click on Direction button. Direction Control 

window will show. Accept the default base angle East. 

 

 
 

AutoCAD’s Angle Direction Control dialog box 
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In the User/Drawing Information section, enter the following data: 

Section Example Text 

Title Mechanical Part 

Subject TurboCAD for AutoCAD Users 

Author Your Name 

Keywords Tutorial, Mechanical 

Click Next. 

5. Page 4 of the wizard determines the scale. This is perhaps the most important step,

because it affects the scale factor of scale-dependent drawing elements, such as text,

dimensioning, and hatch patterns. Examine the mechanical part you plan to draw, and

then add up the widths and heights of each view. Allowing a half-inch around the edges

for dimensioning:

• The overall width is 6" (0.5" + 3" + 0.5" + 1.5" +   0.5") 

• The overall height is 6.5" (0.5" + 3.5" + 0.5" + 1.5" + 0.5") 

a. Since you want to fit the drawing on an A-size sheet, which is 11" wide and 8.5" tall,

select the Scale Type of E n g i n e e r i n g .

b. Specify the Scale of “1"=1" (Full Size).”

c. Click Next.

TurboCAD’s Wizard - Page 4 dialog box 
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6. Page 5 of the wizard asks if you would like to create a viewport in paper space. This is 

useful for lesson 3, so click the Create Default Viewport option, and then N e x t . 

 
TurboCAD’s Wizard - Page 5 dialog box 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



TurboCAD for AutoCAD 
Users 

28 

 

 

7. Finally, Page 6 of the wizard asks if you would like to save the settings for the next time 

you start a new drawing. This is beneficial when all your drawings have similar settings. 

 
TurboCAD’s Wizard - Page 6 dialog box 

For this tutorial, just click Finish. 
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AutoCAD: Creating Layers 
The next step in setting up new drawings is adding layer names and properties. In every new 

drawing, AutoCAD automatically creates a single layer, named “0,” just like TurboCAD. 

1. Create layers by selecting Layer from the Format menu. AutoCAD displays the Layer

Properties Manager dialog box.

AutoCAD’s Layer Properties Manager dialog box 

2. Create four new layers with the properties listed in the table below:

New Layer Names Color Linetype 

Steel Black Continuous 

Dims Red Continuous 

Hatch Yellow Continuous 

Hidden Blue Hidden 

To create new layers, click the New Layer icon. AutoCAD creates a new layer with the 

default name of “Layer1.” 

3. To name the layer, select the “Layer1” text, and then replace it with the proper name. In

this case, type “Steel,” and then press Enter.

4. To create layer Dims, click New Layer and type “Dims.”
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TurboCAD: Creating Layers 
The next step in setting up new drawings is adding layer names and properties. In every new 

drawing, TurboCAD automatically creates a single layer, named “0,” just like AutoCAD. 

1. From the Options menu, choose Drawing Setup - Layers. TurboCAD displays the 

Drawing Setup dialog box with the Layers view showing. 

Notice that this dialog box handles many aspects of setting up drawings, such as specify-

ing the grid, setting the rendering environment, and creating new line styles. 

 
TurboCAD’s Drawing Setup dialog box for layers 

2. Create four new layers with the properties listed in the table below: 

 

New Layer Names Color Style (Linetype) 

Steel Black Continuous 

Dims Red Continuous 

Hatch Yellow Continuous 

Hidden Blue Hidden 

 

To create new layers, click the New icon. TurboCAD creates a new layer with the 

default name of “Layer_1.” 

3. To name the layer, select the “Layer_1” text, and then replace it with the proper name.  

In this case, type “Steel,” and then press Enter. 

4. To create layer Dims, click New and type “Dims.” 
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To change the color of this layer from black to red, click the small black square in   the 

Color column. AutoCAD displays the Select Color dialog box: 

 
AutoCAD’s Select Color dialog box 

5. Click the red square, then click OK. AutoCAD changes the layer color from black to red.  

6. Add layer “Hatch,” and then change its color to yellow. 

7. Add layer “Hidden,” and then change its color to blue. 

8. To change the linetype to Hidden, click the word “Continuous” in the Linetype column. 

AutoCAD displays the Select Linetype dialog box. 

 

 
 

AutoCAD’s Select Linetype dialog box 

a. No linetypes are loaded in new AutoCAD drawings, so click the Load button. 

AutoCAD displays the Load or Reload Linetypes dialog box
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To change the color of this layer from black to red, click the word “Black” in the Color 

column. TurboCAD displays another dialog box that lists its 16.7 million colors: 

TurboCAD’s layer colors 

5. Double-click Red. TurboCAD changes the layer color from black to red, and then

dismisses the color dialog box automatically.

6. Add layer “Hatch,” and then change its color to yellow.

7. Add layer “Hidden,” and then change its color to blue.

8. To change the linetype to Hidden:

a. Click the continuous line in the Style (a.k.a. linetype) column. TurboCAD displays the

linetype droplist:
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b. Scroll down and select “Hidden,” and then click OK. AutoCAD loads the linetype

from the Acad.Lin linetype definition file into the drawing.

AutoCAD’s Load or Reload Linetypes dialog box 

c. Back in the Select Linetype dialog box, select “Hidden” and OK. AutoCAD sets the

hidden linetype pattern to the Hidden l a ye r .

9. Back in the Layer Properties Manager dialog box, click “Steel” layer, and then click    the

Set Current button to set it as the working layer.

10. Click OK to dismiss the dialog box. Ensure that Steel is the current layer by looking at

the Layers toolbar.

AutoCAD’s Layers toolbar 
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Notice that all linetypes are loaded in a new TurboCAD drawing, but are unnamed. 

b. Scroll down, and then double-click the line style that looks the most like hidden. 

TurboCAD sets the hidden linetype pattern to the Hidden layer. 

9. Click OK layer to dismiss the Drawing Setup dialog box. 

10. To set the “Steel” layer as the active (a.k.a. current) layer, select it from the Properties 

toolbar: 

 
TurboCAD’s Properties toolbar 

 
 
 
 
 
 

 
TIPS:    In TurboCAD, layers also control display order, line width, and print styles of entities. 

Linetypes can be constructed using the Line Styles | New option in the Drawing Setup dialog box. See the 
figure below: 

 

TurboCAD’s built-in linetype customization 
facility 
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TurboCAD’s Property Toolbar 
 

ENTITY STYLE. Applies 
predefined property 
settings to a drawing 
tool; does not change the 
properties of selected 
objects. Create entity 
styles with the Format 
| Properties command. 

PEN COLORS. Selects 
the pen color; as in 
AutoCAD, color 
“ByLayer” matches the 
color to the current 
layer. “ByBlock” 
matches the block 
color. 

BRUSH PATTERN 
(a.k.a. hatch pattern): 
Selects a fill pattern for 
closed objects; patterns 
can be customized. 

TEXT FONT: Selects a 
font for text (when 
Text tool is selected); 
all SHX and TrueType 
fonts are available. 

 
 
 
 
 

 

LAYERS. Sets the 
active (a.k.a. current) 
layer. 

PEN STYLE (a.k.a. 
linetype): Selects the 
style of the line. 
“ByLayer” matches 
the line style to the 
current layer. 
“ByBlock” matches 
the block line style. 

PEN WIDTH: 
Selects the 
width for any 
object. 

TEXT HEIGHT: Sets 
the height of text 
(when Text tool is 
selected). 

 
 
 

 
 

 
PROPERTIES: 
Provides 
additional 
brush, general, 
pen, and text 
settings with 
Format | 
Properties. 

 
 
 
 
 
 

 
 
 
 

TurboCAD’s Properties | Text dialog box 
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TurboCAD’s Layers Drawing Setup 
 

LAYER SET: Displays 
groups of layers. 

 
 
 
 
 
 
 

Visible / Not Visible 
(a.k.a. Thawed / Frozen) 

 

  
Editable / Read-only 
(a.k.a. Unlocked / Locked) 

NEW: Creates a new 
layer. 

DELETE: Erases a layer 

LAYER: Names of the 
layer. Maximum length 
= 255 characters. 
Maximum number = 
unlimited layers. 

COLOR: 
TurboCAD allows 
16.7 million colors. 
Default color = 
black. 

STYLE (a.k.a. 
linetype): TurboCAD 
has 12 default styles; 
styles can be 
customized and 
include text and 
shapes. 

ORDER (a.k.a. draw 
order): Determines the 
order in which layers 
are drawn. Default = 
0; max = 32767; 2 
overlaps 1. 

 
WIDTH (a.k.a. line 
weight): Specifies the 
width of all objects 
when width is set to 
ByLayer. 

PRINT STYLES 
(a.k.a. plot styles): 
Specifies color and 
line style used for 
printing. 

without warning.   
 
 

 

SET PREFIX: Automatically assigns a 
sequential layer number when you 
click OK without changing the name. 
In the Prefix dialog box, the @ symbol 
represents the number. Blocks, 
groups, and symbols can also be auto- 
named. 

SWITCH ALL VISIBLE (OFF): 
Sets all 
layers to visible — or not visible 
— at one time. 

SWITCH ALL READ-ONLY (OFF/ON): 
Sets all layers to read-only — or 
editable — at one time. 

 

 
 
 

 

TIP:    To set the active layer, use the Layers list box of the Properties toolbar. 
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AutoCAD: Setting the Snap and Grid Spacing 
1. To set the snap and grid spacing, select Drafting Settings from the Tools menu.

AutoCAD displays the tabbed Drafting Settings dialog box. (If necessary, click the Snap

and Grid tab.)

Click Snap On and Grid On to turn on the cursor snap and grid display.

2. Looking at the diagram of the mechanical part, note that you need to draw to the

nearest 0.05". For the X Spacing, type 0.05. Press Tab and AutoCAD automatically fills

in the Y Spacing with the same value.

AutoCAD’s Drafting Aids dialog box 

You want the grid to display every half-inch, so for the X Spacing type .5. 

Press Tab and AutoCAD automatically fills in the Y Spacing. 

3. For Major Line Every, type 5.
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TurboCAD: Setting the Snap and Grid Spacing 
1. To set the drawing modes — ortho, snap, and grid spacing — select Grid from the 

Options menu; this displays the Drawing Setup dialog box again. 

2. Looking at the diagram of the mechanical part, notice that you need to draw to the 

nearest 0.05". In the Spacing section, set X and Y to 0.05". In TurboCAD, this sets the 

snap distance and the “minor” grid spacing, as shown by the figure below: 

 
Left: TurboCAD’s Grid setup 
Right: Advanced Grid setup 

Change the value of Hide grid when finer than to   0.04. 

3. To set the “major” grid (a.k.a. the grid spacing in AutoCAD), click the Advanced Grid item. 

For Minor X and Minor Y Divisions, type 5. This causes TurboCAD to display the major 

grid at five times the spacing of the minor grid. 

 
 

TIPS: While AutoCAD has ortho, isometric, and perspective grids, TurboCAD also displays grid markings as 
dots, crosses, or lines. It also includes a polar grid. 

 

Unlike AutoCAD, TurboCAD has no “ortho” button on its status bar to toggle orthographic mode. That’s 

because TurboCAD draws in ortho mode any time you hold down the Shift key. 
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4. Click OK to dismiss the dialog box. AutoCAD displays the grid. 

Looking at the status line, confirm that SNAP and GRID are turned on. 

Click the ORTHO to turn on orthographic   mode. 

 

AutoCAD drawing with grid turned on 

 
 

5. Use the View | Zoom | Extents menu pick to ensure you see the entire drawing. 
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4. Click OK to dismiss the dialog box. 

TurboCAD displays the major grid in blue and the minor grid in light blue. Looking at 

the ruler, confirm the grid spacing. 

 

 
 

TurboCAD’s drawing with the grid turned on 

 
5. Use the View | Zoom | Extents menu pick (or press Ctrl+Backspace) to ensure you see 

the entire drawing. 

 
 
 

TIPS: By default, TurboCAD turns off the aperture cursor. To turn it on, select Options | Preference. In the 
Drawing Cursor area, turn on the Show Snap Aperture option, and then click OK. TurboCAD’s aperture 
cursor is round, as illustrated below. 
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AutoCAD: Saving the Drawing 
1. To name the drawing, select Save As from the File menu. AutoCAD displays the Save As 

dialog box. 

 
AutoCAD’s Save As dialog box 

 

 
2. Select a convenient folder in the Save In droplist. 

3. For the File Name, type “Mechpart,” and then click Save. 

AutoCAD saves the drawing. 
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TurboCAD: Saving the Drawing 
1. To name the drawing, select Save As from the File menu. TurboCAD displays the Save 

As dialog box. 

 
TurboCAD’s Save As dialog box 

 

 
2. Select a convenient folder in the Save In droplist. If necessary, change the type of 

drawing from Templates to Drawings. 

3. For the File Name, type “Mechpart,” and then click Save to save the drawing. 

4. Notice that the Summary Info dialog box appears. Click OK to dismiss it. 

TurboCAD saves the drawing. 
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TurboCAD’s Snap Modes 
Object snaps are crucial for accurate drawings, and TurboCAD shares many snap modes with AutoCAD, 
plus provides several unique ones. In addition, TurboCAD has snap priority. This is useful when more 
than one snap mode is turned on, and one needs to be more important than the others. 

Same as AutoCAD 

The following TurboCAD snap modes are identical to AutoCAD’s: 

Apparent intersection Center Grid Intersection Middle 

Nearest Ortho Perpendicular Quadrant

Tangent 

You can access TurboCAD’s snap modes from the local menu’s Local Snap item (right-click shortcut menu), 
the Snap Modes toolbar, and the Modes | Snaps menu, as well as through single-keystroke shortcuts. 

TurboCAD has running snaps (always on) and temporary snaps (on for just one selection). 

Additional Snap Modes 

TurboCAD provides two classes of snaps: 

• Geo — extended ortho, apparent intersection, and show magnetic point.

• Snap — all other snap modes.

Using buttons on the Edit bar, you can quickly toggle between the two classes of snap 
modes:    
TurboCAD has these snap modes not found in AutoCAD: 

Center of extents snaps to the center of the 2D bounding rectangle or 3D box that defines the extents of 
2D and 3D objects. 

Divide snaps to division points along lines and arcs; you specify the number of segments in the Drawing 
Aids dialog box (default = 4). Nearest AutoCAD equivalents are M2P (midpoint two points), or the Divide 
command NODe Osnap. 

Extended Ortho snap to points located orthogonally from the current point. 

Nearest on Facet snaps to the nearest point on facets, or to projections onto the current workplane. 

Opposite snaps to a point mirrored about another object. 

Projection snaps perpendicular to a selected object, from the last point drawn; can be on the selected object or 
projected from it. 

Vertex snaps to endpoints of lines, arcs, and curves, and to the corners of polygons. Nearest AutoCAD 
equivalent is a combination of Endpoint and Intersection snaps. 

Workplane intersection snaps to the intersection of 3D objects and the current workplane. 



TurboCAD for AutoCAD 
Users 

44 

 

 

 

Snap Priority 

TurboCAD provides a way to prioritize snaps. For example, when endpoint and quadrant snaps are both 
turned on, which should have priority when selecting an arc? To access snap priority, right-click SNAP on the 
Edit bar. 

 

TurboCAD’s dialog box for setting snap priorities 

 
 

The Priority column determines which snap mode takes precedence when more than one is available. The 
values range from 1 to 254, where 1 is the highest priority. 

When priority is the same, then the snap point closest to the cursor is selected. When the In Aperture 
Only option is turned on, then the snap mode operates only when a snap point is within the aperture. 
When this option is off, the snap point need not to be within the snap aperture. 

The Show Magnetic Point option is similar to AutoCAD’s AutoSnap Magnet feature. 
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Summary 
Congratulations! You’ve set up your new drawing in TurboCAD. Even though the drawing 

doesn’t seem to have anything in it (except many grid lines), it already carries much information. 

In this lesson, you learned how to start TurboCAD, set up the drawing parameters, and save 

the drawing. In the next lesson, you start to draw with TurboCAD. You create the mechanical 

part with a variety of drawing and editing commands. 

At this point, you can exit TurboCAD by selecting Exit from the File menu. When you want 
to continue with Lesson 2, double-click the TurboCAD icon. After TurboCAD starts, load the 

MechPart.Tcw drawing file from the File - Open menu. 
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2 

Inserting Objects 
Lesson 2: Drawing, Editing, and Creating Blocks 

 
 

In this lesson, you begin drawing the mechanical part in 2D. TurboCAD drawings are 

created by drawing objects, such as rectangles, lines, circles, and arcs. It also creates and 

inserts blocks. As objects are drawn, you may enter coordinates, use relative coordinates, 

turn on object snaps, and lock values (a.k.a. point filters). Although you do not type the 

names of commands, as you can with AutoCAD, you do have the option to override 

parameter values, such as length and angle. 

In TurboCAD, you can start commands in a variety of ways: 

• Select the command from the menu bar, such as Draw| Line | Single. 

• Or, select the icon from the Tools palette. 

• In Default UI, click the related icon on one of the left toolbars, such as  
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While you cannot type command names, many commands offer keyboard shortcuts. See 

Appendix for the complete list. 

 
TIP:    Drawing commands are found in the Draw menu item. Think of this as inserting object. 

Starting to Draw 
If TurboCAD is not running, start it now. From New TurboCAD 2019 Drawing Dialogue, 

select the Mechpart.tcw drawing you created in Lesson 1. 

To draw the mechanical part, begin with the front view in the lower-left corner of the 
drawing.  The TurboCAD version of this tutorial continues on the opposite page. 

 

AutoCAD: Drawing Construction Lines 
To make it easier to draw the mechanical part, start by placing construction lines. First place 

horizontal xlines, followed by vertical ones. To place the xlines at precise spacing, ensure 

snap mode is turned on. 

1. Unlike TurboCAD, AutoCAD does not automatically place construction lines on their 

own layer. Use the Layer command to create a new layer named “Construction” with a 

pale blue color. 

2. From the Draw menu, select Construction Line. AutoCAD prompts you: 

_xline specify point or [Hor Ver Ang Bisect Offset]: H 

Type H to select the horizontal option, and then press   Enter. 

3. AutoCAD prompts you: 

Specify Through point: 

Specify the following positions: 

0, 0 0, 0.5 0, 2.0 0, 3.5 0, 5.0 

4. To draw the vertical construction lines, select Draw | Construction Line, and then type V 

for the vertical option. Specify the following positions to place the vertical construction 

lines: 

0, 0 0.75, 0 1.5, 0 2.25, 0 3.0, 0 5.5, 0 7.0, 0 

 
The drawing now contains a grid of construction lines, which will help you to place drawing 

elements quickly, such as rectangles, lines, and circles. 
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TurboCAD: Inserting Construction Lines 

To make it easier to draw the mechanical part, start by placing a series of construction lines 

(a.k.a. xlines). Construction lines are infinitely long and are displayed but not plotted. 

TurboCAD’s construction lines are automatically placed on layer “$CONSTRUCTION,” 

drawn in a light blue color and dashed pen style (a.k.a. linetype). 

As in AutoCAD, TurboCAD lets you place vertical, horizontal, and angular construction lines 

— though not rays. (TurboCAD also has a command to place construction circles.) In fact, 
you can use any object as a construction object by setting the layer to $CONSTRUCTION 

prior to drawing the object. 

1. Prepare for drawing: 

a. Turn on Grid Snap by clicking its icon. This ensures construction lines are placed at 

                     precise grid spacing. To do this, go to Modes – Snaps. 

b. Turn on Show Magnetic Point (a.k.a. the AutoSnap magnet). This forces the cursor 

                     to jump to the nearest grid point . 

c. Because it is hard to see construction lines when the grid is on, turn off the grid by 

clicking off the Show Grid button. The grid is now like AutoCAD’s snap: invisible 

but activated. (As an alternative, you could change the color of the construction lines 

by editing the properties of their layer.) 

2. Start to draw the construction lines: from the Draw menu, select Construction | 

Horizontal Line. TurboCAD prompts you, “Define the position of the horizontal 

construction line.” 

3. On the Coordinate bar, enter 0 for X, and then lock the value, as illustrated below: 

Enter Y value to place 
Lock X values to 0 horizontal construction lines 

 
Locking the x coordinate and entering y coordinates 

Press Tab to enter each of the following values for Y, followed by pressing Enter: 

0 0.5 2.0 3.5 5.0 

Notice that the construction lines are drawn at each y-coordinate position. 

4. To draw the vertical construction lines, select Draw | Construction | Vertical Line. 

Unlock the X, and then lock the Y value at 0. Enter the following X coordinates to place 

the vertical construction lines: 

0 0.75 1.5 2.25 3.0 5.5 7.0 

              When done, click the racing flag. Remember to unlock the Y .  

The drawing now contains a grid of construction lines, which will help you quickly place 

drawing elements, such as rectangles, lines, and circles. 
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AutoCAD’s construction lines 

Even though AutoCAD has automatic backup, it is a good idea to save the drawing when you 

complete a portion. Press Ctrl+S to save your valuable work. 

 

AutoCAD: Drawing Rectangles 
With the grid of construction lines in place, begin drawing the mechanical part by placing 

rectangles. You’ll employ two methods to draw them accurately: (1) using intersection object 

snap, and (2) typing coordinates and options. 

 

Intersection Object Snap 

The quick and easy way to place rectangles is to snap the corners to the intersection of 

construction lines. 

1. Begin by switching to layer Steel.
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TurboCAD’s construction lines 

Even though TurboCAD has automatic backup, it is a good idea to save the drawing when 

you complete a portion. Press Ctrl+S to save your valuable work. 

 

TurboCAD: Inserting Rectangles 
With the grid of construction lines in place, begin drawing the mechanical part by placing 

rectangles. You’ll employ two methods to draw them accurately:  

(1) using intersection object snap, and  

(2) typing coordinates and options. 

 

Intersection Snap 

The quick and easy way to place rectangles is to snap the corners to the intersection of 

construction lines. 

1. There is no need to switch to layer Steel, because TurboCAD automatically switches away 

from layer $CONSTRUCTION when you select another command. 
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2. From the Draw menu, select Rectangle. At the command line, AutoCAD prompts you:

_rectang 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 

3. Change the object snap mode via the shortcut menu:

a. While holding down the Ctrl key, right-click the mouse button.

b. From the cursor menu, select Intersection.

AutoCAD’s shortcut menu of object 
snaps 

4. With the Rectang command still active, move the cursor to the origin 0",0". Click to

define the first corner.

5. Move the cursor to 3",0.5" by watching the coordinates on the status bar, then click to

define the second corner.

First rectangle in AutoCAD 
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2. From the Draw menu, select Rectangle. Notice that the cursor changes to a cross. On 

the status line, TurboCAD prompts you, “Define the first corner of the b ox .” 

3. Change the snap mode by a different method: instead of using icons on the toolbar, use 

the right-click menu. When you right click, TurboCAD displays a context-sensitive local 

menu (a.k.a. shortcut menu). From the local menu, select Local Snap | Intersection. Or, 

simply press the letter Shift+I. 

 

TurboCAD’s local menu of snaps 

4. With the Rectangle command still active, move the cursor to the origin at 0",0". Notice 

the intersection snap icon displayed by TurboCAD. 

 

 
Snap aperture (black circle) 

Red circle indicates intersection found   Icon for intersection snap 

 

TurboCAD’s intersection snap icon 

Click to define the first corner. 

5. Move the cursor near to 3",0.5" by watching the Coordinate bar. Local snaps work only for 

one cursor pick, so press I when the cursor is near the intersection of the two construction 

lines. (Do not click the mouse button — there’s no need!) See figure on the AutoCAD side. 

Notice that the Edit bar displays the rectangle’s Size A (width) as 3" and Size B (height) 

as 0.5". 
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6. Draw two more rectangles by following the table and the figure shown on the TurboCAD 

side. Because the second rectangle has all four corners filleted, you can use the Fillet 

option to place a filleted rectangle: 

Command: rectang 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ 

Width]: f 

Fillet radius for rectangles <0.0000>: .125 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ 

Width]: (Pick.) 

Specify other corner point or [Area/Dimensions/Rotation]: (Pick.) 

Three rectangles in AutoCAD 

 

 

AutoCAD: Typing Coordinates and Parameters 

In drawing the first three rectangles, you used Intersection object snap on the xlines. When a 

rectangle needs to be placed where no construction lines exist, you could draw more 

construction lines. The drawback is that too many construction lines make the drawing too 

cluttered. The alternative is to enter x, y coordinates. 

1. Start the Rectang command again, and remember to turn off   filleting: 

Command: rectang 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ 

Width]: f 

Fillet radius for rectangles <0'-0.125">: 0 
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6.  Draw two more rectangles by following the points illustrated in the figure below. Re- 

member to press I instead of the left mouse button.

Rectangle Size Pick Points 

First rectangle 3" x 0.5" ... 

Second rectangle 1.5" x 3" 1 and 2 

Third rectangle 0.5" x 1.5" 3 and 4 

Point 1 

All three rectangles in TurboCAD 

TIPS:    If, at any time, you need to exit a command, press the Esc key, just as in AutoCAD. 

To undo previous command(s), press Ctrl+Z, click the Undo icon, or select Undo from the Edit menu. As in 
AutoCAD, TurboCAD can undo all the way back to the beginning of the editing session. 

TurboCAD: Typing Coordinates and Parameters 

To draw the first three rectangles, you used intersection snap with the construction lines. 

When a rectangle needs to be placed where no construction lines exist, you could draw more 

construction lines. The drawback is that too many construction lines clutter up the drawing. 

Instead, use the Inspector bar and the Coordinate bar to place the other rectangles precisely. 

1. TurboCAD keeps the current command active, so there is no need to restart it.

Point 2 

Point 4 

Point 3 
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Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ 

Width]: .75,4 

2. That fixes the lower-right corner of the rectangle. AutoCAD lets you define the size of 

the rectangle with the Dimensions option: 

Specify other corner point or [Area/Dimensions/Rotation]: 2.25,4.5 

This creates the fourth rectangle. 

3. To place the final rectangle, use x, y coordinates of 6, 0.5 for one corner and 6.5, 2.75 

for the other. 
 

 

 
AutoCAD: Drawing Circles 

Five rectangles in AutoCAD 

With the basic outline formed by rectangles, you can now place the circles. 

1. The drawing has a pair of concentric circles, so you’ll use the Circle command twice. 

From the Draw menu, select Circle | Center, Radius. 

2. Turn on Intersection object snap. 

3. Pick at the intersection of the xlines at 1.5”, 2". 

4. AutoCAD prompts: 

_circle Specify center point of circle or [3P/2P/TTR (tan 

tan radius)]: int of <pick at the intersection of 1.5,2> 

Diameter/<Radius>: .25 
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Press Ctrl+R to enter the X field, and then enter the x, y coordinates of the rectangle’s 

first corner: 

X: .75, and then press Tab. 

Y: 4, and then press Enter. 

TIP:  You don’t have to enter the inch symbol if you don’t want to. TurboCAD automatically uses the 
default unit set in Units and Scale. 

 

2. The lower-right corner of the rectangle is fixed. To define the other corner of the 

rectangle, move the cursor roughly into position, and then press Tab to enter the 

Inspector bar: 
 

TurboCAD’s Inspector bar 

Size A: 1.5, and then press Tab. 

Size B: 0.5, and then press Enter. 

That creates the fourth rectangle. 

3. Use the same method to place the final   rectangle: 

Step 1: Press Ctrl+R to enter the Coordinate bar. X= 6, and then press Tab. 

Step 2:  Y= 0.5, and then press Enter. 

Step 3: Press Tab to enter the Inspector bar. Size A= 0.5, and then press Tab. 

Step 4:   Size B= 2.25, and then press   Enter. 

The result looks like the figure on the AutoCAD side of the page. 
 

TurboCAD:  Inserting Circles 

With the basic outline formed by rectangles, you can go on to place the circles. 

1. Because the drawing has a pair of concentric circles, from the Draw menu select Circle | 

Concentric. TurboCAD prompts you, “Define the center point of the circles.” 

2. Select the Intersection snap icon. Ensure the SNAP button is turned on. 
 

Snap (object snap) turned on Geometric aids turned on 

 
 

Toggling snaps and aids 

3. Click at the intersection of   1.5,2. 

4. TurboCAD prompts, “Define the radius of the circle.” 

Press Tab, specify Radius of 0.25, and then press Enter to insert the first   circle. 
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5. Press Enter to repeat the Circle command. 

_circle Specify center point of circle or [3P/2P/TTR (tan tan 

radius)]: 

Enter 0.5" for the Radius. AutoCAD draws the second circle. 

Diameter/<Radius>: 0.5 

6. Save your drawing with Ctrl+S. 
 

Concentric circles added 

 
 
 

AutoCAD: Copying and Mirroring Entities 
The top view has four bolt holes. The obvious way to draw them is to draw one circle, and 

then copy it three times. 

1. Draw a circle with center at 0.375", 4.625" with radius    0.125". 

2. There is no need to run the Select command (as in TurboCAD), because AutoCAD 

always reverts to select mode after most commands. 

3. Click the circle you just completed. It turns dashed, and is surrounded by five blue 

squares. 

4. Select Copy from the Modify menu. AutoCAD prompts you: 

_copy specify base point or [Displacement mode]: 

5. Specify the displacement by entering   2.25<0. 



TurboCAD for AutoCAD 
Users 

58 

 

 

 

5. Press Tab, and then enter 0.5" for the Radius of the second circle. 

6. Save your drawing with Ctrl+S. See the figure on the AutoCAD side for the result. 

 

 
TIPS:    Notice that TurboCAD allows you to specify circles by radius, diameter, or the length of its circumference 

— the latter is not available in AutoCAD. 

TurboCAD has many ways to place circles, as found under the Draw | Circle menu selection. Contrasted with 
AutoCAD, these are: 

TurboCAD Circle Commands Equivalent AutoCAD Circle Option 
 

Center and Point, radius Center and Radius 

Center and Point, diameter Center and Diameter 

Center and Point, circumference not available 

Concentric not available 

Double Point 2P 

Tangent to Arc or Curve use TANgent object snap 

Tangent to Line use TANgent object snap 

Triple Point 3P 

Tangent to 3 Arcs TTR 

Tangent to Entities use TANgent object snap 

 
 

 

TurboCAD: Copying and Mirroring Entities 
The top view has four bolt holes. The best way to create them is to insert one circle, and then 

copy it three times. 

1. Draw a circle at 0.375, 4.625 with radius 0.125. 

2. From the toolbar, click the Select icon. The cursor changes to the standard Windows 

pointer arrow. 

3. Click the circle you just completed. It turns pink and is surrounded by colors grips. 

 

Circle selected 
 

4. From the Modify menu, select Array | Linear. TurboCAD prompts you, “Define the 

step position of the reference point.” 

5. Press Tab, and then change X Step from 0 to    2.25. 
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6. Press Enter at the next prompt: 

Specify second point or <use first point as displacement>: (Press Enter.) 

Notice that AutoCAD copies the circle. 

7. To place the two lower bolt holes, you will use the Mirror command. First, select the first 

bolt hole, and then select the second   one. 

8. Select Mirror from the Modify menu. AutoCAD prompts you: 

Command: _mirror 2 found 

First point of mirror line: mid 

Use MIDpoint object snap to mirror the holes accurately. 

9. Click the midpoint of the vertical line, as indicated by the figure below. 

10. At the “Second point” prompt, click the other vertical line. When AutoCAD asks, “Delete 

old objects?” answer N. Notice that AutoCAD inserts the lower two bolt holes. There is 

no need to press Esc to remove the selection set. 
 

Holes to be mirrored 

 
MID of MID of 

 
Mirrored copies 
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AutoCAD: Drawing Arcs 

 
AutoCAD drawing with four holes 

Finish off the rounded portion of the mechanical part by placing an arc. Use the “SCE” 

method to draw the arc, as follows: 

1. Select Arc | Start, Center, End from the Draw menu. 

2. AutoCAD prompts you to indicate the arc’s starting point: 

_arc specify start point of arc or [Center]: int 

of (Click at the intersection of xlines at 2.5", 2.0".)
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6. Set Y Step = 0, and then press Enter. 

TurboCAD copies the circle. Press Esc to remove the selection box. 

7. To place the two lower bolt holes, you will use the Mirror command. First, select the first 

bolt hole, and then hold down the Shift key while selecting the second bolt hole. 
 

Press Shift to add to selection sets 

 

8. From the Modify menu, select Copy Entities | Mirror. TurboCAD prompts you, 

“Define the first point of the mirror line.” 

9. Turn off grid snap, and then turn on Middle Point object snap. (It is far quicker in 

TurboCAD to press the M key for Middle Point snap, then to change snap modes all the 

time.) 

10. Click the midpoint of the vertical line, as indicated by the figure on the page opposite. 

(Or, move the cursor to the line, and then press M. That snaps to the middle of the line 

without clicking the mouse.) 

11. At the “Define the second point of the mirror” prompt, click the other vertical line. 

TurboCAD inserts the lower two bolt holes. 

Press Esc to remove the selection box (a.k.a. selection set). 

 

TIP: The original selection stays selected. To perform a mirror — rather than a mirror copy — press Del 
to remove the original selection. 

 

TurboCAD: Inserting Arcs 

Finish off the rounded portion of the mechanical part by placing an arc. TurboCAD has eight 

ways to draw arcs as shown by the Draw | Arc menu selection. It is difficult to compare 

TurboCAD’s eight methods with those of AutoCAD, because TurboCAD uses a different 

methodology. In AutoCAD, you draw most arcs by specifying a start, center, and/or endpoint; 

in TurboCAD, you usually define the start and end angles. To draw this arc, use the double- 

point method, as follows: 

1. From the Draw menu, select Arc | Double Point. (Notice that the Edit bar lets you 

specify the arc’s diameter, circumference, angle, start angle, end angle, and   length.) 

2. TurboCAD prompts you, “Define the first point on the arc or circle.” Ensuring Intersec- 

tion snap is turned on, click at the intersection of construction lines at 2.5", 2.0". 
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3. At the next prompt, specify the arc’s center:

Center/End/<Second point>: _c Center: int 

of (Click at the intersection of xlines at 1.5", 2.0".) 

Notice that AutoCAD draws an arc. You now complete the definition of the arc by 

specifying the endpoint. 

4. AutoCAD prompts you to complete the arc:

Angle/Length of chord/<End point>: int 

of (Click at the intersection of xlines at .75", 2.0".) 

Like TurboCAD, AutoCAD draws arcs in the counter-clockwise direction. 

AutoCAD: Drawing Lines 

AutoCAD drawing with arc 

To connect the arc with the base rectangle, use the Line command. 

1. Select Line from the Draw menu bar:

_line from point: (Pick the endpoint of the arc you just drew.) 

2. Complete the line when AutoCAD prompts:

To point: 1.5<270 

3. Repeat for the second line connecting the arc’s other   endpoint.

At this point, the new part of your drawing should look like the figure below. Save the 

drawing. 
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1. Indicate arc's starting angle 2. Indicate arc's ending angle 

3. At the “Define a second point on the arc or circle’s circumference” prompt, click at the

intersection of construction lines at 1.5,   2.0.

Notice that TurboCAD draws a circle. You define the arc by specifying its starting and

ending angles.

Center of arc Radius of arc 

TurboCAD’s arc starts as a circle 

4. TurboCAD prompts you, “Define the start angle of the arc.” Like AutoCAD, TurboCAD

draws arcs in the counter-clockwise direction, so click at the starting point to the right.

See figure above.

At the “Define the end angle of the arc” prompt, click at the ending point to the left. As

you move the cursor, notice how TurboCAD sweeps the arc. When you click, the arc is

complete.

See figure on the AutoCAD side for the completed arc.

TurboCAD: Inserting Lines 

To connect the arc with the base, use the Line command. 

1. From the Draw menu, select Single line. TurboCAD prompts you, “Define the start

point of the line.” Pick the endpoint of the arc you just drew. (Or, press the V key for

Vertex snap.)

2. When TurboCAD prompts, “Define the end point of the line,” move the cursor straight

down to connect with the base. (If you prefer, you can type 1.5 in the Length field and

270 in the Angle field.)

3. Repeat for the second line connecting the arc’s other endpoint.

At this point, your drawing should look like the figure on the next page. Save the drawing. 
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Vertical lines added 

 
 
 
 
 

 

AutoCAD: Filleting Corners 
The base of the mechanical part has a 1/8" fillet on all top corners. Earlier, you drew a 

rectangle with fillets at its four corners. Here you fillet the two remaining rectangles with the 

Fillet command. 

1. Filleting works best when object snap mode is set to Nearest. 

2. From the Modify menu, select Fillet. 

_fillet 

Current settings: Mode = TRIM, Radius = 0'-0.13" 

Polyline/Radius/Trim/<Select first object>: r 

3. Type R to change the radius from 0.5" to 0.125": 

Enter fillet radius <0'-0.00">: 0.125 

4. Now fillet two lines: 

Select first object or [Undo/Polyline/Radius/Trim/Multiple]: 

(Pick one line.) 

5. At the “Select second object” prompt, click an adjacent line. AutoCAD applies the fillet. 

Select second object or shift-select to apply corner: (Pick 

another.) 
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Zooming In and Out with TurboCAD 

To get a closer view of what you are working on, you may find these two TurboCAD icons useful: 

The View / Zoom Window icon works exactly like AutoCAD's Zoom Window command. Pick two points and 
TurboCAD zooms into that rectangle. 

The Zoom Extents icon displays the entire drawing, as in AutoCAD. The keyboard shortcut for Zoom Extents is 
Ctrl+Backspace. 

TurboCAD's zoom commands are found in the View | Zoom menu: 
 

TurboCAD Zoom Option TurboCAD Shortcut Key Equivalent AutoCAD Command 

Zoom In + Zoom 2x 

Zoom Out - Zoom 0.5x 

Zoom Window ... Zoom Window 

Extents Ctrl+Backspace Zoom Extents 

Full View Shift+Backspace Zoom All 

Printed Size ... Preview 

Aerial View ... DsViewer 

Previous View ... Zoom Previous 

Pan to Cursor Ctrl+End Pan 

 

TurboCAD: Filleting Corners 
The base of the mechanical part has a 1/8" fillet on all top corners. That means you apply the 

Fillet command eight times: four in the top view, and twice on each of the front and side 

views. 

1. The Fillet command works best when snap mode is set to Nearest on Graphic.  Click the 

icon or right-click to display the local menu. 

2. From the Modify menu bar, select Fillet. 
3. Press Tab, and then change the Radius from 1" to   0.125". 

4. TurboCAD prompts you, “Select the first entity.” Click one line, as shown in the figure. 

A pair of square handles indicates the selected line. 
 

 
 

Fillet 

Grips indicate first line  
 

Intersection to be filleted 

Select second line 

 

 
Selecting the first entity for filleting 

5. At the “Select the second entity” prompt, click an adjacent line. TurboCAD applies the fillet. 
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Corners filleted 

6. Continue filleting corners, as shown in the figure. 

Save your work. 

 

AutoCAD: Making and Inserting Blocks 
This mechanical part has a round bearing surface. Since this appears four times in the 

drawing, you create it as a block, and then insert the block in the drawing. 

1. Ensure the layer is Steel and the linetype is Continuous. Add more xlines, if you think 

you will find them helpful. 

2. Draw the 0.1" thick bushing face with Draw | Polyline. 
 

The shape of the bushing 

3. To end the Polyline command, press Enter. 
 

The bushing drawn as a polyline 
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6.  Continue filleting corners, seven more times, as shown in the figure on the AutoCAD

side. Notice how quick the filleting process is (as contrasted with AutoCAD), because

TurboCAD automatically repeats the Fillet command.

See the figure on the AutoCAD side for the finished result. Save your work.

TIP    TurboCAD’s Inspector bar provides these filleting options: 

Create lines and arcs from filleted polyline Fillet polyline 

Radius 

Double lines Clean up intersection 

Delete gaps Delete cut lines 

Fillet polyline fillets all corners of polylines. 

Create lines and arcs breaks a filleted polyline into lines and arcs. 

The Fillet command also works on double lines. 

TurboCAD: Creating and Placing Blocks 
The mechanical part has a round bearing surface. Since it appears four times in the drawing, 

create it as a block, and then place it in the drawing. TurboCAD has three forms of grouping 

objects together — in contrast with AutoCAD’s two: 

TurboCAD AutoCAD Equivalent 

Block Block 

Group Group 

Symbol ... 

A symbol differs from a block in these two ways: (1) it can be stored on disk in any file format, 

whereas a block cannot, because it is an integrated part of the active drawing; and (2) each 

time a symbol is placed, it is copied, whereas a block is referenced. 

1. Add more construction lines, if you find them helpful.

2. Draw the 0.1" thick bushing face with Draw | Polyline. Hold down the Shift key to

draw lines horizontally and vertically. Enter values in the Inspector bar, if you find it

helpful.

3. To end the Polyline command, click the Finish flag on the status bar. (Don’t press Esc,

because that removes the polyline from the drawing.)
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4. To create the block, select the polyline. AutoCAD highlights it with handles.

5. From the Draw menu, select Block | Make. Notice that the Block Definition dialog box

appears.

AutoCAD’s Block Definition dialog box 

6. To make it easier to place the block, change the base point. Under Base point, click the

Pick Point button. The dialog box disappears and AutoCAD prompts:

_bmake Insertion base point: (Pick the MIDpoint of the polyline.) 
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4.  To create the block, click the Select icon. Select the polyline that you just drew.   (Or press 

the F7 key, which is a shortcut for selecting the last-drawn object.) 

Notice that TurboCAD highlights it with handles. 
 

TurboCAD’s polyline highlighted with handles 

    5. From the Format menu, select Create Block. The bushing disappears. 

Alternatively, you could drag it by its reference point into the Blocks palette. 

6. To see the bushing block, select Blocks (Ctrl+Shift+B) from the Tools menu. This 

displays the Blocks palette. 
 

 

          Copy  

 

              Edit block (content) 

 
        Replace references 

            Close palette

Large icon, small    Delete block 
icon, list view 

 

Icon of block 

 
 
 
 
 
 

 
TurboCAD’s Blocks palette 

 
 

TIP: When the palette appears, notice that TurboCAD automatically gives the block the name of 
“Block_0.” You can change the automatic name that TurboCAD gives blocks, groups, and symbols with the 
Options | Auto- Naming command. The Program Setup dialog box displays the Auto-Naming tab. 
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7. To name the block, type “Bushing” for Block Name. Ensure that the Convert to Block 

option is turned on. Click OK. 

8. To place the block, select Block from the Insert menu. When the Insert dialog box 

appears, ensure “Bushing” is shown in the Name droplist. 

 

AutoCAD’s Insert dialog box 

Set the following insertion parameters: 

• Insertion point    Specify On-screen 
• Scale X = Y = Z = 1.0 

• Rotation 180 

Click OK, and then place the bushing block in the drawing. The block’s insertion point lines 

up with the construction lines. (You may find it easier to place when osnap is turned off.) 

Original block 

 
 
 
 
 
 

Block insertion 
point 

 
 
 
 
 

Block inserted 
at 180 degrees 

 
 
 
 
 
 
 
 

Block inserted   Block inserted 
at 90 degrees at 270 degrees 

 
 
 
 
 
 

Blocks inserted in drawing 

9. Place the block three more times. When required, use the Rotation parameter to rotate 

the block by 90 and 270 degrees.  Save your work. 
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7. To change the name of the block, double-click it and TurboCAD displays the Edit Block 

dialog box. Change the name to “Bushing,” and then click OK. 

 

 

TurboCAD’s Edit Block dialog box 

8. Ensure Vertex snap is turned on. Place the block by dragging it from the palette into the 

drawing. 

9. Place the block three more times, as illustrated by the figure on the AutoCAD side. 

When required, use the Rot Z parameter on the Inspector bar to rotate the block by 90 

degrees. (Alternatively, use the rotation handle; hold down the Shift key to rotate the 

block in 90-degree increments.) Save your work. 
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AutoCAD: Changing Linetypes and Layers 
The five holes in the mechanical part show up as hidden lines in all three views. First, draw 

the hidden lines in the top view. 

1. Place a pair of xlines on layer Construction to help draw the hidden lines, as shown in 

the figure. Use INTersection object snap to place the lines   accurately. 

2. From the Layers toolbar, select layer “Hidden,” and ensure linetype Hidden is active. 

3. Select Draw | Line, and then draw the two hidden lines, as shown in the figure. 
 

Hidden lines 

4. Repeat to draw the remaining hidden lines. 

Save your work. 
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TurboCAD: Changing Linetypes and Layers 
The holes in the mechanical part show up as hidden lines in all three views. First draw the 

hidden line in the top view. 

1. On the Properties toolbar, select layer Hidden and linetype Hidden (looks like a short-

dashed line). 
 

TurboCAD’s Property toolbar 

2. Place a pair of construction lines to help draw the hidden lines. Remember to use 

Intersection snap to place the lines accurately. Note how the construction lines retain 

their own properties; they do not take on the properties you set above in step 1 . 

3. Ensure the Line tool is still selected and draw the two hidden lines, as shown in the 

figure.  See the figure illustrated on the AutoCAD side. 

4. Repeat to draw the remaining hidden lines. 

Save your work. 

 
TIP To remove construction lines, you cannot simply erase them. Instead, use the Edit | Clear | Construction 
menu item, and then pick the construction lines to remove. By having a separate erase command for 
construction lines, you can erase objects in drawings (or even all objects) without affecting construction 
lines. 
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TurboCAD’s Entity Styles 
In AutoCAD, you can create named objects for views, fonts, layers, and so on. These named 
objects (a.k.a. tables) predefine viewpoints, text styles, layer properties, etc. 

TurboCAD takes that concept a step further by allowing you to create styles for entities. Just like 

styles in a word processor, TurboCAD’s entity styles predefine the properties of objects. 

Entity styles are independent of layer settings. Unfortunately, you cannot apply a style to 

selected objects, nor can you define a style from a selection set. Entity styles can be created in 

Style Manager Palette in Tools: 
 

 

 
You create entity styles with the Properties dialog box Properties in inspector bar or Local 
Menu using these steps: 

1. Set the properties. 

2. Click the Style list box. 

3. Enter the style name. 

4. Click New. TurboCAD adds the style to the Properties toolbar and makes it the default. 

 

General Properties 

The General page sets the following properties: 

 
 
 
 
 
 
 
 
 
 

 

 
Preview area 

 

 
 

General page of the Properties dialog box 

 
 

• Attribute includes any sort of text with the object (a.k.a. extended entity data). 

• Layer specifies a previously-defined layer. 
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• Print Style specifies a previously-defined print style (color and line style).
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• Style creates the new style name; simply type the name in the text box; default = “Normal 
Lines.” 

 

Pen Properties 

The Pen page sets the color and pattern (a.k.a. linetype) of objects: 

 

Pen page of the Properties dialog box 

 
 

• Pattern selects the line type; note that one is named $INVISIBLE. 

• Dash Scale sizes the pattern; equivalent to AutoCAD’s linetype scale. 

• Alignment forces the pattern to fit along the line’s length. 

• Color specifies the color. 

• Width (line weight) gives a width to any object using World (absolute) or Device (relative) scaling. 

• Value specifies the width of lines, from 0" to 2". 

• Geometry applies thickness to 2D objects. 

 

Brush Properties 

The Brush page sets the hatch pattern parameters: 

• Pattern select a predefined hatch pattern, solid fill, or none; you can define custom patterns (brush 
styles) as vector hatches, bitmaps, or gradients. 

• Color specifies the color of the brush. 

• Scale specifies the size of vector patterns. 

• Angle specifies angle of the pattern. 
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• Crossed repeats the pattern 90 degrees to the first one. 

• Background color specifies the underlaying color of the pattern. 

• Origin specifies World (uses WCS origin) or Entity (lower-left corner of object being 

hatched) for the origin of the hatch pattern. 

• Offset X and Y move the hatch pattern’s origin from 0,0. 

• Draw Mode specifies Winding (pattern covers overlapping areas) or Alternate 

(pattern skips alternating overlapping areas); equivalent to island detection in 
AutoCAD. 

• Transparency (%) specifies translucency of solid and gradient fills; 0 = opaque, 100 = 
invisible. 

 

 

Brush page of the Properties dialog box 
 

TIP:    Gradient fills must be defined using Brush Styles. 

 

3D Properties 

The 3D page sets parameters for creating 3D objects: 

• Create 3D Object As specifies Solid (3D solids created by the ACIS modeler) or TC 

Surface (3D surfaces created by TurboCAD’s own modeler); AutoCAD uses the ACIS-
based ShapeManager modeler. 

• Thickness specifies default thickness for 2D objects. 

• Object Specific Faceting can be controlled on an individual object basis via the Properties of 
the object. Object specified faceting overrides the global setting in the ACIS settings.



TurboCAD for AutoCAD 
Users 

78 

 

 

 

 
Luminance Properties 

3D page of the Properties dialog box 

The Luminance page sets parameters for placing lights in 3D scenes: 

• Renders: Select which render engine you wish to select a material from: RedSDK, LightWorks, 
or both. 

• Category: Groups of Luminances such as complex, single, sky, or the name of an open drawing. 

• Material: This field depends on the category. For example, if the Category is sky, etc.  

• Edit Luminance: The list of the Luminances available in the selected category.  

• Available In: Shows which of the render engines have definitions for the selected luminance. 
RedSDK, LightWorks, or both. 

• Load to render luminance only: If on, the geometry of the luminance object is hidden and only 
the illumination effects are shown. 
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Luminance page of the Properties dialog box 
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Material Properties 
Properties related to material for the 3D objects. They are not enabled for 2D objects. 

Custom Properties 

The Custom page records TurboCAD parameters selected through the Define Property 

button: 

• Property lists the name of the property. 

• Value specifies value for the property. 

• Define defines the types of information to be recorded. 

• Regenerate updates the database. 

 

 

Custom page of the Properties dialog box 

 
 

 

Summary 
Congratulations! In this lesson, you did a lot of drafting. You inserted rectangles, circles, 

arcs, lines, and polylines. You used TurboCAD’s snaps, Edit bar, and Inspector bar. You 

learned how to create and insert blocks. 

In the next lesson, you learn how to dimension with TurboCAD, place text, and plot the 

drawing. 

At this point, you can exit TurboCAD by selecting File | Exit from the menu bar. When you 

want to continue with the next lesson, double-click the TurboCAD icon. After TurboCAD 

starts, open the MechPart drawing.
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3 

Applying the Finishing Touches 
Lesson 3: Dimensions, Paper Space, Text, and Plots 

 
 

In this lesson, you apply finishing touches to the mechanical part drawing. 

 

Activities in this Lesson 

• Dimension using horizontal, vertical, and radial dimensions. 

• Switch to paper space. 

• Place and modify text. 

• Plot the drawing with the Page Setup and Print commands. 

If TurboCAD is not running with the drawing from Lesson 2 loaded, start TurboCAD now, 

and load the MechPart drawing. Alternatively, you can double-click the MechPart.Tcw file in 

Windows Explorer; this action loads both TurboCAD and the drawing. 
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Dimensioning with TurboCAD 
TurboCAD’s dimensioning capability is similar to AutoCAD’s. Dimensions are associative. TurboCAD’s 
associative dimensions move and stretch when the associated object is moved and stretched. For example, 
rotate an object and the dimension rotates with it. 

In addition to the dimension commands, you can create dimension styles in TurboCAD: right- click and select 

the Properties dialog box for modifying the dimension style. You can also do this from Style Manager palette. 

TurboCAD Dimension Commands AutoCAD Equivalent 
 

Orthogonal DimLinear 

Parallel DimAligned 

Distance 1 ... 

Rotated DimRotated 

Datum DimOrdinate 

Baseline DimBaseline 

Continuous DimContinue 

Incremental ... 

Angular DimAngular 

Radius DimRadius 

Diameter DimDiameter 

Leader Leader, QLeader 

Quick QDim 

... 2 DimCenter 

... 3 Tolerance 

1    Places constrained dimensions between parallel lines; not available in AutoCAD. 
2    Not available in TurboCAD. 
3 Select from Dimension | Tolerance or Customized > Commands > Tolerance 

 

Creating Dimensions in TurboCAD 

Dimensioning in TurboCAD is similar to AutoCAD: 

Step 1:  Start a dimensioning command. 

Step 2:  Select points or entities to locate extension lines. 

Step 3:  Pick a point to locate the dimension line. 

You can change the dimension text, angle, and length of the extension lines in the Inspector bar. The < 
angle brackets > indicate the default text as measured by TurboCAD. The padlock icons allow you to place 
dimensions with fixed text, at a fixed angle, and with fixed extension lines. 

 

TurboCAD’s Inspector bar for orthogonal dimensions 
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TurboCAD contains a variety of dimension tools that you can use to display the measurements of lines and angles. 

Dimensions consist of three basic components: 

Dimension lines, with arrows pointing to either end of the dimension. A linear dimension can have an interior 
dimension line or two exterior dimension lines. Exterior dimension lines can be supplemented with an optional 
interior line. 

Extension lines, which connect the dimension line to the object being dimensioned. Extension lines have optional 
line segments that continue the extension outward beyond the dimension line (extensions to the extension). 

Dimension text, typically displaying the distance being dimensioned in World units. 

• Entity — applies dimensions to entire entities:

1. Select an entity to dimension 2. Specify dimension line location

Pick one entity and locate the dimension line 

• Quick — applies dimensions to all related geometric features:

1. Click the entity; then 
double-click to end selection. 

2. Specify the dimension line location

Pick two points and locate the dimension line 

• Constraint — uses dimensions to constrain the positions of entities.

TIP: Since the drawing has a scale of 1:1, it is not necessary to set the dimension scale. If you need to 
change the scale of dimensions in work space (a.k.a. model space), change the value of Dimension Size 
Scale in the Advanced Format tab of the Properties dialog box. To have paper space dimensions displayed 
at a different scale, change the value of Linear Measurement Scale in the Advanced Text tab.
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AutoCAD: Drawing Dimensions 

AutoCAD: Object Dimensions 

1. Freeze layer “Construction,” because you don’t need the construction lines anymore. 

Switch to layer “Dims” by selecting the name from the Layer toolbar. 

2. From the Dimension menu, select Linear. 

3. You enter AutoCAD’s “entity” dimensioning mode when you press Enter at the prompt, 

‘...press ENTER to select’, as follows: 

_dimlinear 

First extension line origin or press ENTER to select: (Press Enter.) 

4. Pick the bottom line of the base, as shown in step 4 on the TurboCAD side. 

Select object to dimension: (Pick line.) 

5. Move the mouse downward so that the dimension pulls away from the base. 

6. Click the mouse button to place the horizontal dimension. 

7. Complete the entity dimensioning with the Dimension | Linear and Dimension | 

Radius commands. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     
 
 

Mechpart drawing with entity dimensions 
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TurboCAD: Inserting Dimensions 

TurboCAD: Entity Dimensions 

1. Freeze layer “$Construction,” because you don’t need the construction lines anymore. 

Switch to layer “Dims” by selecting the name from the Properties toolbar. 

2. Select Dimension | Orthogonal. This command inserts horizontal and vertical 

dimensions. 

3. To turn on entity dimensioning, right-click to display the local menu. 

              Select Entity Dimensioning so that the icon (to the left) darkens. 

 

TurboCAD’s local menu toggles dimensioning modes 

4. Select the bottom line of the base, as shown in the f igure. 

TurboCAD’s entity dimensioning 

5. Move the mouse downward, so that the dimension pulls away from the base. 

TurboCAD positioning the dimension line 

6. Click the mouse button to place the dimension. 

7. Continue dimensioning the horizontal and vertical portions of the drawing. 

Use the Dimension | Radius command for round parts. 

TurboCAD’s radial dimensioning 
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AutoCAD: Segment Dimensions 

To dimension the distance between the mounting holes on the base: 

1. From the Dimension menu, select Linear. 

2. While holding down the Ctrl key, right-click and then select Center osnap mode. 

3. When AutoCAD prompts you, pick the first circle. 

_dimlinear 

First extension line origin or press ENTER to select: (Pick circle.) 

4. Then, pick the second circle: 

Second extension line origin: (Pick circle.) 

5. Drag the dimension away from the base, and then click the mouse button to place the 

dimension. 

Dimension line location (Mtext/Text/Angle/Horizontal/Vertical/ 

Rotated): (Place dimension.) 

6. Press the Enter key to repeat the Dimlinear command, and then dimension the   vertical 

distance between the mounting holes. 

7. Save your work with Ctrl+S. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     
 

 

Mechpart drawing with completed dimensioning 
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TurboCAD: Segment Dimensions 

One area of the mechanical part cannot be entity-dimensioned: the distance between the 

mounting holes on the base. 

1. Select Dimension | Orthogonal. 

2. Right-click and deselect (turn off) Entity Dimensioning. 

3. TurboCAD prompts you, “Define the first extension line origin or use local menu to 

select.” Place the cursor near the first circle, and then press C. TurboCAD snaps the first 

extension line to the center of the   circle. 

TurboCAD snapping to the first circle 

4. At the “Define the second extension line origin” prompt, move the cursor to the second 

circle, and press C again. 

TurboCAD snapping to the second circle 

5. When TurboCAD prompts, “Define any point on the dimension line,” drag the dimen- 

sion away from the base, and then click. 

TurboCAD positioning the dimension line 

6. Dimension the vertical distance between the two holes. 

7. Save your work with Ctrl+S. 
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AutoCAD: Switching to Paper Space 
Before placing text and plotting the drawing, switch from model space to paper space (layout 

mode). 

1. Click the Layout1 tab. (If the Page Setup Manager dialog box appears, click Close.) 

Notice that the model appears in a viewport. 

AutoCAD model appears in layout viewport 
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TurboCAD: Switching to Paper Space 
Before placing text and plotting the drawing, switch the working space (a.k.a. model space) to 

paper space. TurboCAD handles paper space somewhat differently from AutoCAD. In both 

CAD programs, you first create one or more viewports in paper space. In AutoCAD, you then 

pan and zoom the model to get the view you want in each viewport; in TurboCAD, you select 

a named view to display in each viewport. 

1. Let’s take a look at how this works: 

a. Click the Paper 1 tab. Notice that TurboCAD opens a blank paper. 

 
b. From the View menu, select Viewport. TurboCAD prompts you to pick the two 

points that form the viewport’s corners. 

c. Notice that the Named View dialog box appears. Choose View_0, and then click Go 

To. “View_0” is TurboCAD’s generic name for the entire model view. You can create 

additional named views for showing details. 

 
TurboCAD’s Named View dialog box 

Notice that the viewport fills with the model space view. 

TurboCAD’s viewport with view into model space 
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2. To add the title block and drawing border, use the Insert | External Reference com- 

mand. AutoCAD does not make it easy to attach title block drawings. With the Look In 

droplist, make your way over to the following folder: 

C:\Users\<login name>\AppData\Local\Autodesk\AutoCAD 

2019\R23.0\enu\Template 

(Autodesk chose to place the drawing border files in a hidden folder: Local Settings.  If 

you cannot find it, you need to turn off the Do Not Show Hidden Files and Folders 

option in Windows Explorer — found in the Tools | Folder Options | View dialog box.) 

3. Select “Generic 24in x 36in Title Block.dwg” file, and then click Open. 

4. Position the title block drawing in model space. 

If the drawing interferes with the title block, you may need to reposition the viewport 

and scale the drawing. 

AutoCAD model positioned outside of title block 
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2. To add the title block and drawing border, use the Insert | File command. TurboCAD 

makes it easy to attach title block drawings: select Templates from the droplist. 

 
TurboCAD’s Insert File dialog box 

3. Select “ANSI A .tct” from path C:\Program Files\<login 

name>\TCW2019\Template, and then click  Open. 

4. Position the title block drawing in model space. 

If the drawing interferes with the title block, you may need to reposition the viewport 

and scale the drawing. 

TurboCAD’s title block and drawing border 
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AutoCAD: Drawing Text 
Fill in the title block by following these steps: 

1. Zoom in to the title block area with the Zoom Window command.

2. Click the Draw | Text | Multitext icon. AutoCAD starts the MText command:

_mtext Current text style: STANDARD. Text height: 0.2000 

AutoCAD specifying the Mtext 
rectangle 

3. Pick two points to specify the rectangle in which to place the text:

Specify first corner: (Pick a point.) 

Specify opposite corner or [Height/Justify/Rotation/Style/Width]: 

(Pick another point.) 

4. When the Multiline Text Editor appears, type “Mechanical Part.”

5. If you need to make the text larger, use the mouse to select the text, which highlights it.

Change the default text height from 0.2. (If you don’t first select the text, AutoCAD does

not change its size.)

6. Change the font from the ugly-looking Txt font to something bolder, such as Arial Black

or any other font found on your computer.

AutoCAD adding text to the title block 

7. When finished with the text, click OK, and AutoCAD places the text in the drawing.
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TurboCAD: Inserting Text 
Like AutoCAD, TurboCAD uses TrueType and SHX-format fonts for text in its drawings. You 

can use all of AutoCAD’s fonts in TurboCAD drawings. (To create AutoCAD-like text styles, 

you go through the process described in the previous chapter for creating entity styles.) 

Fill in the title block by following these steps: 

1. Zoom in to the title block area with the View | Zoom Window command. 

2. On the toolbar, click the Multi Text or go to Draw | Text | Multi Text icon. 

3. Pick two points to specify the rectangle in which to place the text: 

TurboCAD specifying the multi text rectangle 

Define the insertion point for the text (Pick a point.) 

Define the text width and angle: (Pick another point.) 

4. When the Multiline Text Editor appears, type “Mechanical Part.” 

5. If you need to make the text smaller, use the mouse to select the text, which highlights it. 

Change the default text height to 24pt. (If you don’t first 

select the text, TurboCAD does not change its size.) 

6. Change the font to Arial Black or any other font found on 
your computer. 

 
                                                          TurboCAD adding text to the title block 

7. When finished with the text, click the Finish flag icon. 

Notice that TurboCAD places the text in the drawing. 
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AutoCAD: Plotting Drawings 
1. To set up the drawing for plotting, select File | Print.

AutoCAD’s Plot dialog box 

2. Change parameters to make the drawing fit your printer’s paper:

• Printer/plotter - Name — select a printer or plotter from the droplist.

• Plot area - What to plot — select “Layout” from the droplist.
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TurboCAD: Plotting Drawings 
To plot a drawing in TurboCAD, follow these steps: 

a. Choose File | Print to set up the printer. 

b. Click Page Setup to set up the paper. 

c. Click Print to plot the drawing. 

Let’s follow these steps now: 

 
1. From the File menu, select Print. The Print dialog box contains options that primarily 

affect the printer. 

 
TurboCAD’s Page Setup dialog box 

2. Choose parameters to make the drawing fit your printer’s paper: 

• Printer - Name — select a printer or plotter from the droplist. 

• Print range - View — select “*Current View” from the droplist. 

• Fit on 1 page — select to turn on (check mark shows). 
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3. Preview the plot by clicking the Preview button. 

 

 
AutoCAD’s Plot dialog box 

 

4. Click the printer icon on the toolbar to produce a hardcopy of your drawing. 

5. Press Ctrl+S to save the drawing, and then exit AutoCAD with File | Exit. 
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3. Preview the plot by clicking the Page Setup button. The dialog box also controls the 

size, orientation, and optional markings of the paper. You have the option of letting 

TurboCAD print the following: 

• A rectangular margin around the drawing (quick substitute for drawing borders). 

• Crop marks at the four corners (useful for commercial printers). 

• Grid lines. 

• Construction lines. 

 

 
TurboCAD’s Page Setup dialog box 

 
The preview window lets you see what’s happening. 

If the drawing does not fit the page, make the following changes to parameters: 

• Printer Paper — change orientation to landscape. 

• Paper Space Printing Scale — choose “1"=1" (Full   Size)”. 

4. Click the Print button to produce a hardcopy of your drawing. 

5. Press Ctrl+S to save the drawing, and then exit TurboCAD with File | Exit. 
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Summary 
In this lesson, you learned how to dimension the drawing, switch from working space to 

paper space, place text, and plot the drawing. 

In the following chapter, you learn how AutoCAD and TurboCAD produce 3D solid models 

of the same mechanical part. 
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4 

3D Design 
Lesson 4: Designing a Three-dimensional Model 

 
 

CAD software provides several approaches to creating 3D models, including the following: 

• Inserting primitives, and then editing them into shape. 

• Extruding 2D drawings, and then modifying them. 

In this lesson, you use the second approach, because you already have the 2D drawing. The 

result will be a 3D model that looks like the figure illustrated below. 
 

Completed 3D model designed by TurboCAD 
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AutoCAD: Preparing for 3D Modeling 
Prepare to create the 3D model by following these steps: 

1. Three-dimensional modeling is always performed in model space. (Paper space is strictly 
for 2D layouts.) Return to model space by clicking the Model tab. 

 

AutoCAD: Switching from layout mode 

2. You no longer need the construction lines, dimension lines, and hidden lines. Turn off 
the related layers: 

a. On the Layers toolbar, open the layers droplist by clicking on it. 

b. Click the lock icon next to the following layers: 

• Dims 

• Hidden 

• Construction 
 

AutoCAD: Turning off unneeded layers 

3. For 3D modeling tools. Go to Tools menu, select Toolbars | AutoCAD | Modeling. 
 

 

AutoCAD: 3D Make panel 

 

4. AutoCAD also provide Workspace option, through which selected workspace appear. For 
3D Modelling go to Tools (click on Show Menu Bar if it’s hidden) | Workspace | 3D 

Modelling. Menu bar will hide after completion. 
 

5. 3D Basics workspace have basic tools for 3D drawing. 
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TurboCAD: Preparing for 3D Modeling 
Prepare to create the 3D model by following these steps: 

1. Three-dimensional modeling is always performed in model space. (Paper space is strictly 
for 2D layouts.) Return to model space by clicking the Model tab. 

 

TurboCAD: Switching from paper space 

2. You no longer need the construction lines, dimension lines, and hidden lines. Turn off 
the related layers: 

a. On the Object Properties toolbar, open the layers droplist by clicking on   it. 

b. Click the eye icon next to the following layers: 

• Dims 

• Hidden 

• $Construction 
 

TurboCAD: Turning off unneeded layers 

3. The Tools palette is useful for accessing 3D modeling tools. To turn it   on: 

a. Select Tools from the View menu. 

Keep it displayed for the duration of the modeling session by clicking the AutoHide 
pushpin icon; when the pushpin points down, the palette no longer hides 
automatically. 

 

AutoHide pushpin 

 

              Palette Options 

 
 
 
 
 

TurboCAD: Locking the palette into place 

b. From the Sketch droplist, select 3D Model. This displays all 3D modeling-related 
commands. 
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4. From the View menu, select 3D Views, and then select SW Isometric.

Notice that the viewpoint changes to 3D.

5. Save your work with Ctrl+S.

AutoCAD: 2D drawing displayed in 3D viewpoint 
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4. Change the viewpoint to 3D. Right-click the drawing, and then from the local menu, 
click the Isometric SW icon. Notice that the viewpoint changes to 3D. 

 

 

TurboCAD: Selecting the isometric viewpoint 

5. Save your work with Ctrl+S. 

 

   

 

TurboCAD: 2D drawing displayed in 3D 
viewpoint 
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AutoCAD: Simple Extrusion 
To convert the 2D drawing to a 3D solid, use the Extrude command. First, apply it to the 

mechanical part’s base, as found on the former top view. 

1. In Home|Create tab click Extrude. Notice that AutoCAD prompts you: 

Command: _extrude 

Current wire frame density: ISOLINES=4 

2. Select the base, and then press Enter to end object selection. 

Select objects to extrude: (Select the base.) 

Select objects to extrude: (Press Enter.) 

3. When prompted for the extrusion distance, enter -0.5, and then press Enter. 

Specify height of extrusion or [Direction/Path/Taper angle] 

<0'-1.00">: -.5 

Notice that the base extrudes downward by a half-inch. (The reason for extruding it 
downwards is to make it easier to assemble the model later.) 

 

AutoCAD: Extruded base 

4. Repeat for the four holes, extruding them downward by 0.5 inches. 
 

AutoCAD: Extruded base and holes 
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TurboCAD: Simple Extrusion 
To convert the 2D drawing to a 3D solid, use the simple extrusion tool. First, apply it to the 

mechanical part’s base, as found on the former top view. 

1. In the Tools palette, click Simple Extrude in 3D Object section (found in

the 3D Object section). Notice that TurboCAD prompts you:

Select an entity to extrude (Select the base.) 

2. Select the base, and then press Tab to access the Inspector bar.

Lock extrusion height 

Use compound profile 

Finish selection of profile 

Height of extrusion 
(negative values 

extrude downwards) 

Two-sided extrude 

TurboCAD: Inspector bar for the Simple Extrusion tool 

3. Enter -0.5, and then press Enter. Notice that the base extrudes downward by a half-inch.
(The reason for extruding it downward is to make it easier to assemble the model later.)

TurboCAD: Extruded base 

4. Repeat for the four holes, extruding them downward by 0.5 inches.

TurboCAD: Extruded base and holes 
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AutoCAD: Extrusion of Regions 

Before you can extrude the next part, you need to modify the 2D drawing. 

1. Erase the parts shown highlighted (the profile of the base), and replace them with a 
single line segment. 

From the Draw menu, select Line. It easiest to use the ENDPoint keyboard osnap mode 
to connect lines to existing geometry accurately. Use OSNAP command. 

 

Left: AutoCAD erasing the lines and arcs making up the profile of the   base 

Right: Replacing them with a single line 

2. AutoCAD lacks TurboCAD’s abilities to use compound profiles or to make two-sided 
extrusions. The workaround is to create regions and to move the solids, respectively. 

a. From the Draw menu, select Region. 

b. Select the profile (outline) you created in the previous step. AutoCAD creates a 
region that can be extruded later as a solid. 

c. Execute the Extrude command using a height of 0.5". 
 

Left: AutoCAD’s one-sided extrusion 
Right: Circles extruded as cylinders 

d. Use the Move command to move the solid in the z-direction up a distance of 0.1". 

3. Repeat the extrusion for the two circles using a height of 0.7". 

4. Save your work with Ctrl+S. 
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TurboCAD: Two-sided Extrusion of Compound Profiles 

Before you can extrude the next part, you need to modify the 2D drawing: 

1. Erase the parts shown highlighted (the profile of the base), and replace them with a 
single line segment. 

From the Draw menu, select Single. I find it easiest to use the V (vertex) key- board 
shortcut to connect lines to existing geometry accurately. 

 

Left: TurboCAD erasing the lines and arcs making up the profile of the   base 

Right: Replacing them with a single line 

2. For this extrusion, use the compound profile and two-sided extrude options: 

a. From the Tools palette, select Simple Extrude. 

b. On the Inspector bar, click the Compound Profile button to turn on the option. 

Click the Two Sided Extrude button, as well. 

c. Click the profile (outline) you created in the previous step. 

d. For Height, enter 0.25 (half the thickness). Notice that TurboCAD extrudes in 
both directions from the profile. 

 

Left: TurboCAD’s two-sided extrusion 
Right: Circles extruded as cylinders 

3. Repeat the two-sided extrusion for the two circles. Lock the extrusion height to 0.35. 

4. Save your work with Ctrl+S. 
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AutoCAD: Union and Subtract Solids 

In 3D solids modeling, holes are created by subtracting cylinders from the rest of the solid. 

The base has four small holes, the upright part has one large hole. 

1. To create the holes in the base, select Subtract from the Create section in Home Tab. 

2. Notice that AutoCAD prompts you: 

Command: _subtract 

Select solids and regions to subtract from .. 

Select objects: (Pick the base.) 

Select the base, the part from which the cylinders will be subtracted. 

3. Press Enter to end object selection. 

At the next prompt, select the four cylinders. 

Select solids and regions to subtract .. 

Select objects: (Pick the cylinders.) 

4. Press Enter when done. The model won’t look any different. 

Select objects: (Press Enter.) 

5. To confirm that the cylinders have been removed, select View |Visual Styles | Conceptual. 
(There is no hole in the tombstone-shaped part, yet.) 

 

AutoCAD: Draft rendering of base with holes 

Return to wireframe mode: select View | Visual Styles | Wireframe. 

6. To create the hole in the tombstone part, first union the tombstone to the outermost 
cylinder, and then subtract the innermost cylinder, as illustrated on the TurboCAD side. 
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part to.... 

TurboCAD: Adding and Subtracting Solids 
In 3D solids modeling, holes are created by subtracting cylinders from the rest of the solid. 

The base has four small holes, the upright part has one large hole. 

TIP: IMSI/Design provides optional Mechanical Pack for TurboCAD that includes a fully parametric Hole 

tool which simplifies the hole-making and enables you to specify typical hole parameters, such as 
threading and counter-sinking. 

1. To create holes in the base, select 3D Subtract from the Boolean Facet section of the
Tools palette.

2. Notice that TurboCAD prompts you:

Select the first of 3d entities for subtract (Pick the base.) 

Select the base, the part from which the cylinders will be subtracted. 

3. At the next prompt, select one of the cylinders.

Select next operand(s) by click or drag (Pick a cylinder.) 

4. Repeat the process for each cylinder: pick the base, and then another cylinder. The
model won’t look any different.

5. To confirm that the cylinders have been removed, right-click the drawing, and then
select Draft Render. There is no hole in the tombstone-shaped part, yet.

Left: TurboCAD selecting the Draft Render command 
Right: Draft rendering of base with holes 

Return to wireframe mode: right-click, and then select Wireframe. 

6. To create the hole in the tombstone, first add (a.k.a. union) the tombstone part to the
outermost cylinder, and then subtract the innermost cylinder, as illustrated below.

1. Add this "tombstone" 
2. ...the outer cylinder

3. Subtract inner cylinder

TurboCAD: The order in which solids will be added and subtracted 
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a. Click Union in Home | Edit tab. AutoCAD prompts you to pick two solids: Select 

objects: (Select the “tombstone” and the outermost cylinder.) Select 

objects: (Press Enter.) 

After a moment, the two parts are joined into a single part. 

b. Select Subtract, and then subtract the innermost cylinder. 

c. Apply a visual style to check the result. 
 

AutoCAD: Result of adding and subtracting 
parts 

7. Save your work with Ctrl+S. 

 

AutoCAD: Model Assembly 
The next stage is to assemble the two parts: (1) rotate the tombstone around the x axes by 90 

degrees, and (2) move it into place on top of the   base. 

1. Here’s how to rotate the tombstone in 3D space: 

a. Enter the 3DRotate command. 

Command: 3drotate 

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0 

Select objects: (Select the tombstone.) 

Select objects: (Press Enter to end object selection.) 

b. Select the tombstone part. Notice the tri-circle grip   tool. 

Specify base point: (Pick a corner on the tombstone.) 

 

 

 

 

 

Y axis rotation (blue) Relocate basepoint 

Z axis rotation (green) X axis rotation (red) 

 
AutoCAD: Selecting the X axis handle 
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a. In the Tools palette, click 3D Add. TurboCAD prompts you to pick two solids:

Select the first of 3D entities for add (Select the “tombstone”)

Select next operand(s) by click or drag (Select the outer cylinder)

After a moment, the two parts are joined into a single part.

b. Select 3D Subtract from the Tools palette, and then subtract the innermost cylinder.

c. Do a quick render to check the result.

TurboCAD: Result of adding and subtracting parts 

7. Save your work with Ctrl+S.

TurboCAD: Model Assembly 
The next stage is to assemble the two parts: (1) rotate the tombstone around the x axis by 90 

degrees, and (2) move it into place on top of the   base. 

1. Here’s how to rotate the tombstone in 3D space:

a. Press the spacebar to switch to Select mode.

b. Select the tombstone part. Notice the 3D handles.

Y axis rotation 
Z axis rotation 

X axis rotation 

Move handle 

Resize handle 

TurboCAD: Selecting the X axis handle 
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c. Click the red circle, which represents the X axis. 

Pick a rotation axis: (Pick red circle.) 

Notice that it turns yellow, and that a red axis line appears. 

d. Specify the angle: 

Specify angle start point: 90 

Enter 90, and then press Enter. Notice that the part rotates and becomes upright. 
 

AutoCAD: Part rotated upright 

2. The second step is to align the tombstone with the base. This is done with AutoCAD’s 
3dMove command, as follows: 

a. From the Home menu, in Modify tab select 3D Operations | 3D Move. 

b. When AutoCAD prompts you to select the object, select the tombstone, and then 
press Enter: 

Command: _3dmove 

Select objects: (Pick tombstone, and then press Enter.) 

c. You need to tell AutoCAD the basepoint from which to start moving: 

Specify base point or [Displacement] <Displacement>: endp 

of (Pick a bottom corner.) 

Enter ENDPoint object snap, and then pick a corner, as illustrated below. 
 

AutoCAD: Selecting the corner of the base 
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c. Click the green ball at the end the X axis handle.

d. Press Tab until the Rot X field is highlighted on the Inspector   bar.

Enter 90, and then press Enter. Notice that the part rotates and becomes upright.

TurboCAD: Part rotated upright 

2. The second step is to align the tombstone with the base. This is done with TurboCAD’s
assembly feature, as follows:

a. From the 3D Modify menu in tools palette, select Assemble by Edge and Point.
b. When TurboCAD prompts you to select the part, select the tombstone:

Select an entity whose position you wish to change (Pick tombstone.)

c. You need to tell TurboCAD which surfaces to mate:

Select the location of the source line (edge) (Press C, and then

pick a bottom line.) 
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Notice that AutoCAD previews the move with a line. 
 

AutoCAD previews the move with a line 

d. In the same way, specify the destination on the base: 

Specify second point or <use first point as displacement>: endp 

of (Pick the associated corner on the base.) 

Enter ENDPoint osnap again, and then pick the equivalent corner on the base, as 
illustrated below. 

 

AutoCAD: The model shown with hidden lines removed 

 

e. Use the Union command to join the two parts into a single 3D model. 

To clean up the drawing, erase any 2D lines and arcs that are no longer needed. 
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Hold down C (or Shift+C) to invoke the Center object snap, and then pick a line at 
the bottom, as illustrated below. 

 

TurboCAD: Selecting the center of a base line 

d. In the same way, specify the destination on the base: 

Select the location of the destination line (edge) (Press C, and 

then pick the associated line on the base.) 

Hold down C again, and then pick the line on the base, as illustrated below. Notice 
that TurboCAD previews the assembly with dashed lines. 

 

TurboCAD previews the assembly with dashed lines 

To complete the assembly, click the Finish flag icon. Notice that TurboCAD moves the 
tombstone onto the base, as illustrated on the AutoCAD side. 

 
e. Use the 3D Add command to join the two parts into a single 3D model. 

To clean up the drawing, erase the 2D lines and arcs that are no longer needed. 
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AutoCAD: Filleting the Edges 

The final stage is to fillet the top edges of the   base. 

1. From the Modify menu, select Fillet (available in dropdown menu). Notice that 
AutoCAD prompts you to select the model: 

Command: _fillet- 

Current settings: Mode = TRIM, Radius = 0'-0.0" 

Select first object or [Undo/Polyline/Radius/Trim/Multiple]: (Select 

the model.) 

2. Next, specify the fillet radius, 0.125": 

Enter fillet radius <0'-0.0">: 0.125" 

3. Use the Chain option to select the entire top edge of the base, as follows: 

Select an edge or [Chain/Loop/Radius]: c 

Select an edge chain or [Edge/Radius]: (Select the top edge of the 

base.) 

4. Press Enter to apply the fillet. 

Select an edge chain or [Edge/Radius]: (Press Enter.) 

Notice that the edges are blended. 
 

AutoCAD: Filleted 
edges 
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TurboCAD: Blending/Fillet the Edges 

The final stage is to blend (a.k.a. fillet) the top edges of the base. 

1. From the Tools palette, select Fillet Edges — found in the 3D Modify section. Notice 
that TurboCAD prompts you to select the model: 

Select a 3D model for edge fillet (Select the model.) 

2. Next, select the edge to be blended: 

Select an edge to fillet (Select the top edge of the base.) 

Notice that the red handles show the selected edge(s). 

 
 

Select this edge 

 
 
 
 
 
 
 
 

TurboCAD selecting the edges to blend/Fillet 

3. Press Tab to access the Inspector bar, and then enter the following   values: 

 

TurboCAD: Inspector bar for the Blend command 

     4. Click the Finish flag icon. Notice that the edges are blended. 

TurboCAD: Blended edges 
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Summary 
In this lesson, you learned how AutoCAD and TurboCAD produce 3D solid models of the 

same mechanical part. The methods of extruding, subtracting, filleting, and blending, are 

quite similar in the two programs. 

In the final chapter, you learn how to bring AutoCAD drawings into TurboCAD, and the sorts 

of translation issues to watch out for. 
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5 

DWG Import & Export 
Translating Drawings from AutoCAD 

 
 

TurboCAD imports and exports drawings made by CAD and other graphics packages. 

Specifically, TurboCAD imports and exports AutoCAD files with the extensions of DWG 

(short for “DraWinG”) and DXF (the abbreviation for “Drawing interchange Format”). In 

general: 

• You import DWG files when the drawings come from AutoCAD. 

• You would use DXF files when the drawings come from another CAD package. (There 
is no point to importing DXF files from AutoCAD, because that requires the additional 
step of translating from DWG to DXF.) 

Similarly, save TurboCAD drawings in DWG format to be read by AutoCAD. Save TurboCAD 

drawings in DXF format when they will be read by software other than AutoCAD. 

In addition to DWG and DXF, TurboCAD also imports and numerous other file formats, as 

listed later in this chapter. 

In this chapter, we look in detail at how TurboCAD reads and writes DWG files. The process 
is identical for DXF files. We also look at using the Windows Clipboard and OLE mechanism 

to place drawings and other documents in TurboCAD. 
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Accurate DWG Translation 
The translation of a drawing is only considered 100% accurate when no objects (or their 

properties) are erased or changed. Unfortunately, this is never possible between AutoCAD 

and TurboCAD — or between any other CAD packages you care to name. 

Fortunately, TurboCAD does an excellent job of translating drawings; there are errors only 

among very few objects. The following is a concise summary of objects changed when 

importing drawings. 
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Formats Imported and Exported by TurboCAD 
TurboCAD imports and exports a far larger number of formats than does AutoCAD: 

Note: File formats availability with respect to different variants of TurboCAD. Following file formats are those 
available in Platinum: 

Import (Open) Export (Save As) Notes 

Vector file formats 

3DS 3DS Autodesk’s 3D Studio 

3DV ... VRML Worlds 

3DM 3DM Rhino format 

3MF 3MF 3D printing format 

ASAT ASAT ACIS® 

ASC, PCD, PCG ... Point Cloud Data 

... BMP Windows® Bitmap format 

CGM CGM Computer graphics metafile 

DAE DAE COLLADA Model 

DC, DCD ... DesignCAD® format 

DGN DGN Bentley Systems’ MicroStation 

DWF DWF Autodesk’s Design Web Format 

DWG DWG Autodesk’s AutoCAD Drawings 

DXF DXF Autodesk’s Drawing Interchange Format 

EPS EPS Adobe’s Encapsulated PostScript 

FCD ... Evolution Computing’s FastCAD for DOS 

FCW ... Evolution Computing’s FastCAD for Windows 

FBX FBX 3D asset exchange format 

GEO ... VRML Worlds 

... GIF Graphics Interchange format (w/ Alpha Channel Support) 

IFC IFC Industry Foundation Classes 

IGS IGS Initial Graphics Exchange Specification 

... JPG JPEG 

KML, KMZ ... Google Map Format 

OBJ OBJ OBJ Drawing 

PDF PDF Adobe’s Portable Document Format 

... PDF Adobe® 3D Portable Document Format 

PLT PLT Hewlett-Packard’s HPGL Plot 

... PNG Portable Network Graphic (w/ Alpha Channel Support) 

... PRC Adobe PRC-Based Portable Document Format 

Raster Raster (Reference 2D multiple formats) 

SAT SAT Spatial Technologies’ Save As Text (ACIS) 

... SHX Shape file format 

SKP SKP Trimble SketchUp® format 

STEP STEP STEP Drawing 

SAB SAB ACIS® 
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STL STL Stereolithography format 

STP STP STEP Drawing 

... SVG Scalable Vector Graphics 

TAP ... TurboApps® packaged file format 

TCT TCT TurboCAD® drawing template 

TCW TCW TurboCAD® native format 

... U3D Universal 3D 

WMF WMF Microsoft’s Windows Metafile Format 

WRL / WRZ WRL / WRZ VRML Worlds 

XYZ ... Terrain Data 

Raster file formats 

BMF ... Floorplan for Windows bitmaps 

BMP1 BMP Microsoft’s Windows bitmap 

GIF1 GIF CompuServe’s Graphics Interchange Format 

JPG1 JPG Joint Photographic Experts Group 

PNG1 PNG Portable Network Graphics 

1 These raster files are placed in drawings with the Image Manager and Insert Picture commands; 
TurboCAD can also insert images in TIFF, PCX, icon (ICO), and Targa formats. 
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Importing AutoCAD Drawings 
To bring AutoCAD drawings into TurboCAD, use TurboCAD’s File | Open command to 

display the Open dialog box. 

Open file 

Select DWG filetype 

Change import options 

Resize dialog box 

TurboCAD’s Open dialog box 

When the dialog box appears, follow these steps: 

1. Select “DWG - AutoCAD Native Format” from Files of Type droplist. TurboCAD displays

all files with the .DWG extension in the current folder.

2. If necessary, change to another folder and drive with the Look in droplist. TurboCAD

remembers the file extension and folder you select for the next time you use the Open

command.

3. Select the AutoCAD drawing file by name.

4. (Optional) If you want to change the import options, click the Setup button. TurboCAD

displays the DXF and DWG File Import dialog box. In most cases, options are set for the

most accurate translation. You might want to turn on the Create option of Model Space

Viewports. (More details in the section following.)  Click OK to dismiss this dialog box.

5. Back in the Open dialog box, click the Open button to begin importing the drawing.

After a moment or two, TurboCAD displays the AutoCAD drawing.
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At this point, you should carefully check the translated drawing to make sure it is accurate. 

More details appear later in this chapter’s “Accurate DWG Translation” section. 

DWG File Import Options 

The DXF and DWG File Import dialog box is available when importing DWG and DXF files. 

In the Open dialog box, click the Setup button. 

Open 
Mode 

TurboCAD’s DWG and DWF File Import dialog box 

TurboCAD’s DWG/DXF translator can check drawing files for errors: 

• Open without audit opens drawing files without checking for errors. Not recom- 
mended, because when the file has errors, it is not opened by TurboCAD.

• Open with audit fixes some errors when possible, and then displays a report if errors
are found. Caution: Some files may be too corrupt to be repaired, and are not opened by
TurboCAD.

• Recover corrects more errors than simply auditing.

• Show report displays a dialog box listing the errors found, as illustrated below. Close
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the dialog box to finish loading the drawing. 

 
 

 
 
 
 
 
File 
Units 

 
 

 

 

 

TurboCAD’s DWG/DWF File Audit Trail dialog box 

AutoCAD does not use units for its drawings; unit indicators, such as " (inches) are converted 

by AutoCAD from the scientific units it uses internally, and displayed on the run. For this 

reason, you need to specify the units TurboCAD should use for the drawing. For example, if 

the AutoCAD drawing is in Architectural units (feet and inches), select “ft” from the droplist. 

If you are not sure, select the By Drawing option. If the resulting drawing has the wrong 
scale, then re-import it using one of the units listed below. 

 

Unit Meaning Equivalency 
 

English (imperial) units 

mil 

in 

" 

' 

ft 

yd 

mils 

inches 

inches 

feet 

feet 

yards 

1 inch = 0.01 mils 

 
 

12 inches = 1 foot 

 
3 feet = 1 yard 

mi miles 5,280 feet = 1 mile 

 
Metric (international) units 

u micron 1 micron = 0.001 mm 

A Angstrom 1 angstrom = 0.00000001 mm 

mm millimeter 1 mm = 2.54 inches 

cm centimeter 10 mm = 1 cm 

m meter 100 cm = 1 m 
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km kilometer 1,000 m = 1 km 

 
Typesetting units 

pt point 72.72 points = 1 inch 

pica pica 6 picas = 1 inch 

twip twentieth-of-a-point 20 twips = 1 point 
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Default Text Font 

If the drawing contains a font that your computer does not have, chose a replacement font 

from the Default Text Font droplist. You can choose any TrueType (TTF) or AutoCAD (SHX) 

font on your computer. The default is Times New Roman. 

Overwrite Entries 

The following options are meant for use when you insert an AutoCAD drawing into an existing 

TurboCAD drawing with the Insert | File command. 

When AutoCAD and TurboCAD share the same settings, then this section overrides 

TurboCAD’s settings with those of AutoCAD. 

• System variables are where AutoCAD stores many settings. Some of these are similar to
those in TurboCAD, such as units, numerical display format, and angle format. (You
cannot directly change TurboCAD’s system variables, as you can in AutoCAD with the
SetVar command.)

• Views, Blocks, Layers, and Line Styles are identified by name in AutoCAD drawings, as
well as in TurboCAD. Turn on these options to have TurboCAD’s named entities
overwritten with the values of AutoCAD’s.

For example, if the existing TurboCAD drawing has a layer named “Airport” and is colored 

green, inserting an AutoCAD drawing with an “Airport” layer colored red overrides the 

TurboCAD setting, changing the layer color from green to red. 

Set Defaults 

After you’ve made changes to this dialog box, you can quickly return the settings to their 

original values by clicking the Set Defaults button. 

Post-translation Checking 

If, after translation to TurboCAD, you find objects in the drawing that puzzle you, use the 

Select cursor and the Selection Info palette as your investigative tools. 
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Simply click an object – or window a group of objects – and the Selection Info palette 

(equivalent to AutoCAD’s Properties palette) tells you everything TurboCAD knows about the 

object(s). 

 

Examining unknown objects with the Selection Info palette 



Lesson 5  DWG Import & Export 

131 

 

 

 

Exporting in DWG Format 
AutoCAD cannot read drawings created by TurboCAD. To bring TurboCAD drawings into 

AutoCAD, you must translate them first from within TurboCAD by saving drawings in DWG 

format. When you select Save As from the File menu, TurboCAD displays the Save As dialog box. 
 

Select folder and drive 

 
 
 
 
 
 
 
 
 

 

Save file 

 

Select DWG filetype 

 
Save entire drawing 
or a selection set 

 

Resize dialog box 
 

Change export options 
 

TurboCAD’s Save As dialog box 

1. In the Save as type droplist, change the file type to “DWG - AutoCAD Native Format.” (If 

another CAD package needs to read the TurboCAD drawing, save it in DXF format by 

selecting “DXF - Drawing eXchange Format” instead.) 

2. If necessary, change to another folder or drive using the Save in droplist. 

3. Although it is not usually necessary, you can change the file name in the File name text box. 

4. Click the Setup button to display the DWG File Export dialog box. (The setup for DXF 

files is identical). Choose OK to exit setup. 

5. Click Save to save the drawing in DWG (or DXF) format. 
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TIPS:    TurboCAD allows you to save the entire drawing or just a selection set of objects. When you choose 
Selection, TurboCAD prompts you to select the objects to export after you click Save. 

TurboCAD does not save a preview image when saving to DWG and DXF formats. 

 

DWG File Export Options 

The DXF and DWG File Export dialog box provides the following options: 

 

 
Save As 

TurboCAD’s DWG and DXF File Export dialog box 

With some exceptions, older releases of AutoCAD cannot read drawings created by newer 

releases, and so TurboCAD lets you save the drawing in the many release groupings. 

Following are few: 

• AutoCAD 2018 Drawing saves drawings for AutoCAD 2018/2019 

• AutoCAD 2013/2017 Drawing saves drawings for AutoCAD 2013,2017 

• AutoCAD R14 Drawing saves drawings for AutoCAD Release 14. 

Caution: Older releases do not understand objects unique to newer releases and so may erase 

or change objects in order to be compatible. 

 

Other Options 
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Precision applies only to DXF files, which can be in the range from 1 to 16 decimal places.  
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Save As: Select the AutoCAD version. 

Precision: The number of decimal places for numerical values of the exported file. 

Convert Xrefs to AutoCAD Drawing: Converts attached Xrefs into DWG files. 

Rendered Viewports as Images: All viewports that have renderings will be converted to images, 

to preserve the appearance of the renderings. 

Rewrite embedded images: Relevant for files that contain image objects. Choose whether to 
replace images. 

Groups as Blocks: Displays objects included in groups as blocks when imported into AutoCAD. 

Unblock: Explodes blocks into its constituent objects. 

Preserve Hatch Associativity: Retains hatch association in the resulting DWG file. 

Explode Text: Explodes any text into its constituent parts. 

Explode Architectural Objects for DWG: Explodes any TurboCAD Architectural objects into 

data comprehensible to AutoCAD. 

Convert By World Scaled Arcs into Polylines: All arc using the By World setting for line scaling 

will be converted into arc segments of polylines with a supported AutoCAD scaling method. 

Set Fixed Height for Text Styles: (On, Off, don’t check this option):  Locks Height for Text Styles. 

DWG and DXF file formats do not support unit types, only a designation as Imperial or Metric. 

All Imperial units are converted to inches in DWG, all Metric units to mm.
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Embedding and Linking Objects 
There is an alternative to translating drawings between TurboCAD and AutoCAD, and that’s 

not to translate at all. You can place wireframe representations of drawings in the other CAD 

package, and they will look exactly correct, because they are not translated. 

The drawings are embedded as objects, with a link back to the originating application using 

a Windows technology named OLE, short for “object linking and embedding.” 

The method described below works only when both CAD programs are installed on the same 

computer. You can use this method with other software as well, such as placing CAD drawings 

in Word documents, or Visio diagrams in TurboCAD. 

 

Using OLE 

Let’s see how object linking and embedding works: 

1. Open a complex drawing in AutoCAD, such as illustrated below. Ensure the drawing is in 
Model tab. 

If necessary, use the -SHADEMODE command to change the shading to 2dwireframe, 
because beautifully rendered models don’t work through OLE. Even hidden-line removal 
is reduced to regular wireframe mode. 

 

AutoCAD’s drawing 

2. Press Ctrl+A to select all objects in the drawing. 

Press Ctrl+C, the universal keyboard shortcut for copying objects to the Windows 
Clipboard. (Ignore messages about objects on locked layers.) 
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3. Switch to TurboCAD. 

4. Press Ctrl+V. This pastes the AutoCAD drawing from the Clipboard into the drawing. 
Notice that the drawing appears in TurboCAD. 

 

 
 

AutoCAD drawing pasted into TurboCAD 

5. You can use handle editing to move and resize the AutoCAD drawing — technically, an 
object, and not a drawing. Curiously, you cannot rotate it or perform any other editing 
operation, except for erase. 

6. To edit the object, you double-click it. This causes Windows to open the original draw- 
ing in AutoCAD. 

Notice that the object is now cross-hatched in TurboCAD; this means that it is open in 
another application and is unavailable until the other application (AutoCAD) exits the 
drawing. 
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AutoCAD drawing “busy” in TurboCAD 

7. Press Alt+Tab to switch to AutoCAD. Notice that the drawing appears in a new window,
and that it can be fully edited.

In AutoCAD’s File menu, a new item appears: Update TurboCAD. As you edit the
drawing, you can periodically update the drawing back in TurboCAD.

For example, change the colors to blue, and then select File | Update TurboCAD.
Notice that the drawing’s lines are now all blue in TurboCAD. The only changes that
won’t appear are those that involve shading, rendering, and hidden-line removal.

8. When you are finished editing, close the drawing in AutoCAD by selecting Close from
the File menu. AutoCAD asks if you wish to have the changes updated in TurboCAD.

Prompt message will be: Update TurboCAD 2019 Platinum 2019 64-bit before 
closing the object. 

9. Answer Yes or No, as you wish.
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Inserting Objects 

As an alternative to Ctrl+C/Ctrl+V method, you can choose Object from the Insert menu. 

TurboCAD displays the Insert Object dialog box, which lists all the kinds of documents that 

Windows knows about on your computer. (Strictly speaking, this dialog box is generated by 

Windows, and looks identical on any software that has the Object | Insert command.) 

 

Windows Insert Object dialog box 

Choose Create from File, and then click the Browse button. This lets you select a file name, 

which Windows then places into the TurboCAD drawing. 

 

Create from File option 

The files you select are not limited to AutoCAD drawings; they can be just anything: Acrobat 

PDF files, movie clips, Word documents, Excel spreadsheets, digital photographs, and so on. 

Some display as you expect; others show an icon instead. In either case, you can double-click 

the object/icon to edit it in its originating application. 

The Link option creates a live link. When the drawing or document is changed in the original 
application, the changes are made to the copy in TurboCAD automatically. 



Lesson 5  DWG Import & Export 

139 

 

 

 

If you need to change the linked objects, use TurboCAD’s Edit | Links command. This 
displays a dialog box, again common to all Windows applications. 

You can set each linked object so that the update happens automatically, or so that the update 

must be done manually. 

Following are the contents of Edit Links window. 

Links box: contains all the links in the active drawing. You can highlight multiple links by 
pressing Shift or Ctrl. 

Update Option: Sets whether the selected links are updated automatically or manually. 

Update Now: Updates the current link. This is how to update sink that are set to update 

manually. 

Open Source: Opens the file in its source application. This also enables you to compare the 
linked object to the source file. 

Change Source: Enables you to choose a new source for the object. Once the object is linked 
to the new file, its contents will change to match the new file. 

Insert PDF as Underlay: The PDF Underlay tool allows you to insert a page of a PDF file into 

your drawing to use as a reference or tracing layer. To use properly as a tracing layer, the file 

must be a vector PDF, rather than a bit-mapped PDF. 
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Summary 
Despite some difficulties, drawing translation works out well in most cases. With each new 

released version, TurboCAD is made more and more compatible with all new features in latest 

AutoCAD versions. Your typical 2D floorplan is going to translate smoothly. Lines, circles, 

colors, line styles — they all convert effortlessly.



Lesson 5  DWG Import & Export 

141 

 

 

6 

Advanced TurboCAD Tools 
TurboCAD: Customizing the UI 

You can customize toolbars, menus, keyboard, and your IntelliMouse (if you use one). You can 

invoke the Customize window at any time by right-clicking in any blank toolbar area.  

Note: If you prefer an older interface for customizing toolbars and menus, select UI Themes, 

and select the classic interface.  

 
TurboCAD Customize Window (Ribbon UI – Classic Theme)
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Customize Commands 
The Commands page enables you to customize toolbars by adding and removing icons. 

Display the toolbar you want to change, and open the Commands page. Locate the commands 

you want to add to the toolbar, and drag it from the Commands list to the toolbar itself. 

Search Option: 

You can also search a command. Type a command in "find" option to search, the first suitable 

item is highlighted. To browse through the commands, buttons next to the input field 

highlight and can be used to show the previous or next suitable item. Successful search 

options are added to the list and saved between sessions. 
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TurboCAD: Customize Keyboard 
The Keyboard page enables you to view current keyboard shortcuts (hotkeys), to modify 

them, or to create new ones. 

Whenever you make changes to the UI settings it is best to save the Workspace file (under the 

Options tab accessed via Tools | Customize) in order to accurately retain your changes. 

Tip: Select Help / Keyboard for a list of all shortcuts. 
 

 

Multiple Keyboard Shortcuts 
 

You can create two/three (or more) key customizable keyboard shortcuts. For example, 

pressing "aa" might invoke the double point arc if you have assigned this shortcut to it. 

Another usefulness of this feature is that the user doesn't have to do a key combination which 

is difficult when only using one hand. The ideal case would be that the user uses left hand to 

generate the keyboard shortcut and the right-hand to control the mouse. 

Example: 

To assign a multiple keys shortcut to any command: 

1.  Select the command in customize keyboard. 

 

2. Select shortcut key box. 
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3. Press and release Control key. You will see a "Ctrl>" sign. 

 

4. Now press multiple keys. 
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5. Press Assign button and Close.

To invoke the command using shortcut

1. Press and release control key.

2. Press multiple keys in a sequence included in the assigned shortcut.

Note: You can only use CTRL key to assign multiple keys shortcuts to commands. If you 
want to assign a single key shortcut with CTRL, keep CTRL pressed and select another 
key. 

Report: 

You can see a detailed report of keyboard shortcuts by pressing "Report" on customize keyboard. 
A webpage will open in your default internet browser. 
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AutoCAD: Shortcut Keys Customization 
Click Manage tab | Customization panel | User Interface. 

Create or Modify a Shortcut key 

1. In the Customize tab, Customizations In <file name> pane, click the plus sign (+) next to
the Keyboard Shortcuts node to expand it.

2. Click the plus sign (+) next to the Shortcut Keys node to expand it.

3. Do one of the following:

• To create a shortcut key, in the Command List pane, drag a command to the
Shortcut Keys node in the Customizations In <file name> pane.

• To modify a shortcut key, select a shortcut key from under the Shortcut Keys node.

4. In the Properties pane, click in the Key(s) box, and then click the […] button to open the
Shortcut Keys dialog box.

5. In the Shortcut Keys dialog box, hold down the modifier key Ctrl with a combination of
Shift, Alt, or Shift and Alt along with the desired letter, number, function, or virtual key
such as F1 or Insert.

Valid modifier and key combinations include

• Function (Fn) keys containing no modifiers

• Number Pad (NUMPADn) keys containing no modifiers
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• Ctrl+letter, Ctrl+number, Ctrl+function, Ctrl+virtual key 

TurboCAD: Customize Options 
Enables you to manage the configuration (Config) files, control the look of the TurboCAD 
window, and specify external devices. 

 

 

Styles and Themes 
These functions allow you to select from several different Workspace/UI looks, or "skins". 
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Default: uses the "new" (TC28) dark interface with new icons. 
TurboCAD Classic: uses a light background with TurboCAD's classic icons. 
Custom Theme: uses the new icon set, but allows you to choose a skin to customize the look and 
feel of the interface. 
Other: Various settings for how icons and tool-tips are displayed. 

Fonts: Select the font and its size for the selected control. 

Colors: Set color for the selected control. 
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AutoCAD: Customize UI 
This tool is available at Tools > Customize > Interface 

 

Provides an interface for customizing workspaces, toolbars, menus, ribbon panels, shortcut menus, 
and other user interface elements. 
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TurboCAD: Program Setup 
Default UI Menu: Options/Program Setup 

Auto-Naming 

Controls how groups, blocks, and symbols are named.  

Prompt for name: You will receive a prompt each time a new item is created. 
Generate names: Names will be automatically assigned. 
Prefix: If names are automatically generated, you can enter a string that appears before the item 
name. The "@" character is a placeholder for the automatic number. 
Insert blocks when creating: Each block will be inserted into the drawing once it is created. 
Prompt for library location: If not checked, all saved symbols will be stored in the default folder.  

Note: If you turn off both the Prompt for name and Generate names options, names will not be 
assigned to groups. Names will be assigned to blocks and symbols, however. 

 
Color Palette 

Enables you to add, modify, or delete colors from the TurboCAD palette. 

To add a new color, type the name and click New. You will then be prompted to select a color 
from the color wheel. 
You can modify a color by selecting it from the list and clicking Modify. Delete a color by 
selecting it and clicking Delete. 
When you have the colors you want; they can be displayed for easy selection in the Colors and 
Brushes palette.  

The Color Wheel 

You can set colors by RGB values, or by Hue, Saturation, and Value numbers. 
Red, Green, Blue: Sets the amount of each color in the light. Values can be a maximum of 255. 
Hue: The color value, where 0 is red, 60 is yellow, 120 is green, 180 is cyan, 200 is magenta, and 
240 is blue. If you change the hue, the values for red, green, and blue will be changed to match. 
Sat: The saturation level for the color (amount of color), up to a maximum of 240. 
Lum: The luminosity (brightness) of the color. 

 
Constraints 

Settings and controls for geometric and dimensional constraints.   
Auto Add Constraints: If checked, the Auto Add Constraints tool is enabled. Any constrainable 
geometry you create while this is active will have constraint automatically assigned. 
Update Connected Objects while Dragging: Dynamically updates the position, shape and size of 
constrained objects as you drag them within the Edit tool. 
 

Connected Objects Editing: 
DCM Default: Changes to any part of a set of constrained objects can affect all objects equally. 
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Use Priority Level: Constraint changes to any part of a set of objects will affect that part first, with 
minimal changes to the remaining objects. 
Incremental Evaluation: Constraint changes are constantly checked and changes are being made. 
If disabled, the results will be checked only after changes are made. For large scale changes, this 
option should be enabled. 

Constraint Markers and Dimensions 

Place marker to the same layer with object: Constraint markers are placed on the same layer as 
the object that is constrained. Otherwise they are placed on their own layer. 
Show variable name in dimension text: Displays the variable name in parentheses after the 
dimension value. 
Printing: Choose whether constraint markers and constrained dimensions will be included when 
printing. 

 

Desktop 

Controls what appears on the screen.   

Workspace: Controls the display of the working area 
Status Bar: Displays or hides the Status Bar. 
Scroll bars: Displays or hides the scroll bars. 
Rulers: Displays or hides the rulers. 

Inspector bar 

Inspector Bar: Displays or hides the Inspector Bar. 
Classic: Set Inspector bar fields and labels to be in the classic side by side orientation, 
Compact: Set Inspector bar fields and labels to be in the compact over/under orientation, 
Field width: Specify the field width. 

Desktop default scheme 

Desktop Scheme: Customizes the color of paper and background, and floating palettes. 
Click Modify to change an element's color. 

Tip: You can also click the different elements in the preview window. 

Show margins: Displays page (printer) margins. 
Show background: If checked, the background behind the paper will be displayed. If unchecked, 
the background will be white. 
Apply to opened drawings: Apply changes in the scheme to all opened drawings. 
Apply to active drawing: Apply changes to the currently active drawing. 

Tip: You can switch off the paper until you're ready to print, then use the Page Setup to place 
your drawing on the page. 

OpenGL Hardware Acceleration: Available if your video card is equipped with an accelerator, 
take this characteristic into account while performing a render. 
Render new window: When you render your drawing, the render view will open in a new 
drawing window. 
Background Render: With this option, TurboCAD tools work faster in Render mode; rendering 
will "interfere" less with other tools. This setting can only be applied when working with one 
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window. 

Multithreading quality render 

Use automatic number of threads: If checked the system automatically use the full number of 
available threads. 
Threads: Specify the number of threads to be used for rendering if Use automatic number of 

threads is off. 
Multithreading LightWorks: If checked multithreading will be used for LightWorks. 

 

File Locations 

Enables you to specify the folders where TurboCAD places several types of program files.   

Templates (.tct)* - Files in which you save settings as well as block libraries, symbol libraries, 
and scripts, that you can use to start a new drawing. 
Backups (.bak)* - Backups that are created if you check Make Backup Copies option in 
the General page. 
AutoSave Files (.asv)* - Files that are saved automatically, if this option is turned on in 
the General page. These files allow you to restore work after a system crash. 
Symbol Library Files (.slw)* - Sets of related symbols, saved to one common *.slw file, or a set of 
drawing files saved to a specified folder. 
Drawings (.tcw)* - Drawings and models you create in TurboCAD. 
Publish to HTML Files - Files created using File / Publish to HTML.  
Shapes (.shx):* Shape files (*.shx) used in the creating of line styles. (This is not the same as *.shx 
font files.)  

Tip: If you have two disk drives (or access to a network drive), it is wise to have your backup 
files automatically saved to a second drive. 

 

General Setup 

Sets file opening and saving parameters, as well as user information 
New document from: Select how files will be opened when using File / New. 
Default template for new files: If no template is specified when creating a file, a default 
template will be used. This option sets the default template. 
Prompt for template name: You will be prompted for a template each time you start a new file. 
If you want to use the default template without being prompted, clear this box. 
Open all files as read-only: If checked, files cannot be edited. 

 
Make backup copies: If checked, select On First Save or On Every Save to determine how often 
backups will be made. Backup files have the extension .bak. By default, backup files are saved in 
the same folder as your primary drawing files, but you can change this on the File Locations 
page. 
Save drawings every: If checked, autosave copies (.asv files) will be made at the specified 
intervals. After a system crash, TurboCAD will open the autosave version of your drawing as 
soon as you launch TurboCAD. 
Prompt for summary information: The Summary Information window enables you to record 
user information connected to your drawing. If checked, this window will be displayed the first 
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time that you save any drawing to disk, and whenever you use Save As to save a new copy of 
the file. 
Healing of SAT insertions: For imported files, heals gaps between faces and holes within faces. 
Save desktop on exit: If checked, the desktop settings (toolbars, etc.) will be saved when you exit 
the program. 
Load at startup: You can choose to load the last working file and the last window layout each 
time you start TurboCAD. 
Help Settings: Specifies how help will be accessed. 
User Information: Basic user information 

 

Preferences 

General program options, such as cursor shape, axis color, zoom factor, and display of 
coordinate system icons. 

Coordinate system icon: 

You can choose to display the User CS and/or World CS symbol/s. 

For both, you can set the color of the axes and size of the icon.  

Cursor Shape: Select one of the three shapes provided. 

Show crosshairs: Overrides the normal cursor, displaying a screen wide horizontal and vertical 
line intersecting at the cursor position. 

Show Isometric: Overrides the normal cursor, displaying all three axes. 

Show Snap Aperture: Displays a circular area around the cursor whose radius is the Aperture 
Size. Aperture is used while snapping, to detect objects. 

Aperture size: Specify the radius of the aperture in pixels. 

Undo/Redo 

Undo/Redo depth: Sets the number of operations stored in the Undo buffer. 

Include Model / Paper space switch in Undo buffer: If checked, switching between Model and 
Paper spaces will be included in the Undo buffer. 

Selection 

Use Choice if several entities in aperture while selection: If more than one object lies within the 
aperture area during a selection, a small window appears from which you can select the desired 
object. 

Visual Effect Settings: Settings for the various "highlighting" methods. See Selection Visual 
Effects Settings. 

 

Toolbars and Menu 

Open the Customize window to the Toolbars page to modify toolbars. 
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Controls the display of TurboCAD warning messages. If you received a warning message with 
the "Don't show this message again" checkbox, the warning message will appear in this table. Use 
the Show column to show or hide messages. UI enhancements of the Warning dialogs page 
Show/hide list columns. 
Right click on the header of the list to open the local menu.  This make it possible to show/hide 
list columns.  

Native Draw

The Native Draw dialog allows you to specify which display/drawing engine will be used. you 
can select between standard GDI and Redsdk (Addon Plug-in). By default, under Native Draw, 
only GDI mode is available. GDI uses standard Windows CPU based drawing technology and 
CPU based OpenGL hardware acceleration. Redsdk is an OpenGL accelerated drawing engine 
that can substantially accelerate the speed at which entities are drawn. 

GDI Options 

Flicker Free Draw: When this option is turned on the redrawing of entities is made smoother, 
however this can marginally slow down zooming and panning of drawings. 

Redsdk Options – Only available after installing its add-on plugin. Not included in TurboCAD 
by default. 

Hardware: Creates an anti-aliasing effect on 2D graphic elements. The values available are: Off, 
1x, 2x, 4x, 8x, 16x. Turning this on will make the display smoother, but lowers the performance. 
Vertical Synchronization: Makes the display looking better, while moving, however it may 
higher memory usage. 
Text Smoothing: Turning this on will make the display of text smoother, but lowers the 
performance. 
Engine: 

• Wireframe - Sets the engine anti-aliasing in Wireframe mode. Range – [1-5]. By default – 1.
Enabled if Redsdk is On.

• Hidden Lines - Sets the engine anti-aliasing in Hidden Line mode. Range – [1-5]. By default
– 2. Enabled – if Redsdk is On.

• Draft - Sets the engine anti-aliasing in Draft Render mode. Range – [1-5]. By default – 2.

Show Video System Info: Pressing this button will display the current video card setup on 
your computer. If your current driver for the video card is not the optimal driver for Redsdk 
you will be prompted to download the correct driver via a link within the window. If you do 
not download the optimal Redsdk will use a default driver. 
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Render Manager Options 

 

 

General 

You can specify how the Render Manager is displayed by selecting either Classic or Palette-Like 

Classic 

• Variable sized preview. 

• Tree can be hidden. 

• Each category of components is displayed on separate tabs.  

Palette-like 

• Fixed square preview area (240x240)  

• The tree cannot be hidden. 

• While resizing the dialog, only the tree's height and the properties area size change. 

• All properties of the main shader are shown on one page. Components of sub shaders are 
shown on separate pages. 

 

Advanced Preferences 

Advanced options for program control. 

3D Boolean operations 

Transfer material from operand on its facet: When checked, material from one object is 
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transferred onto the other during a 3D Boolean operation (3D add , 3D subtract, etc.). When 
unchecked, the materials are not affected on either object. 

 

Shader Sets 

Copy shaders sets to the application database: Sometimes is will be desirable to copy shaders 
from a drawing into the Application Shaders Manager. To resolve this issue there is an option on 
the 'Preferences' page.  By default, this option is off. When this option is active, when a file is 
opened all shaders sets will not only be added to the Model Shaders manager but also will be 
copied to the Application Shaders Manager. 
Shared shaders sets: This option defines the scheme of work with the render attributes (material, 
luminance, environment, render style). By default, it is off. 
Note: After changing of this option it is necessary to restart TurboCAD. 

 
If this option is ON, then all operations with the render attributes occur according to the "old 
scheme", which was used before TurboCAD 2016.  Namely, the changing of an shader attribute in 
one drawing leads to the changing in all drawings and in the application database. 

Intelligent Scale 

Hatch: When a hatch is created it is automatically scaled to an appropriate size relative to the 
current view. This means in particular to the level of zoom. 
Text: When a text is created it is automatically scaled to an appropriate size relative to the current 
view. This means in particular to the level of zoom. 
Dimension: When a dimension is created it is automatically scaled to an appropriate size relative 
to the current view. This means in particular to the level of zoom. 
Custom Coefficient: This is a scaling multiple that is applied to the intelligent scaling. For 
example, 2 would double the size whereas 0.5 would halve the size. 
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TurboCAD: Palettes 
TurboCAD palettes are convenient screen areas used for performing common tasks and for 
obtaining information. By default, the palettes are displayed on the right side of the screen, and 
contain tabs for easy display and switching. 
The palettes commands are available on the Tools menu in Default Interface. In Ribbon Interface, 
Palette toolbar is not available but these palettes can be access from Tools > Palettes. 

You can also display the Palettes toolbar by right-clicking on any toolbar area and 
selecting Palettes. 

 

 
 

 

Blocks Palette 

A block is a collection of objects combined into a single object. Blocks are useful for storing 
complex, common drawing objects that you will use more than once. Blocks are stored in the 
drawing's internal block library and a block reference, and not the actual object, is inserted into 
the drawing. When a block is edited, all instances of that block in the drawing are updated.  

 

Calculator Palette - Variables Palette 

Enables you to make numerical calculations within TurboCAD, and to define variables. 

 
You can also use this palette to assign constraints to dimensions.  

Mathematical Calculations 

To perform a calculation, enter the values in the top field of the palette, using parentheses as 
needed to create inner expressions. No spaces are allowed. The four mathematical operators 
should be entered as +, -, * (multiply), and / (divide). 

To calculate the result, press Enter. 

You can also use these commonly-used values in place of numbers: 
pi =3.1415926 e =2.71828 
The function (F) button enables you to perform a function on the value in the parentheses. For 

example, select sin  to get the sine of an angle. 
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sin  appears in the calculator field (you also could have entered this expression yourself 
manually). 

Sine is calculated for radians, so if you have a value in degrees it must be converted. Look in the 
functions menu under Units Conversion and select rad(a), which converts degrees to radians. 

 

 

Arrange the expression so that the parentheses are in the correct places, and include the angle in 
degrees (45 in this case): 

   

Press Enter to obtain the result. 

 

Some functions require two values, such as exponentials. Pow (x, y) raises x to the y power. 

Include the values and press Enter to get the result.   

 

Colors and Brushes 

Displays all colors and brushes currently available. By default, the Colors and Brushes palette 
shows colors on the top and brushes (hatch patterns) on the bottom. 
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The color selected at the top and the brush pattern selected at the bottom appear in 
the Property toolbar. These properties become the default for the current tool and other tools in 

the tool group. For example, if Line is active and 
you set a color, this color will become the default for Rectangle, Polyline, etc. The icons at the top 
of the palette are as follows:  

Design Director 

A convenient place to perform commands related to layers, workplanes, views, cameras, and 
objects or object groups. 

Docking Palettes 

Palettes can be docked just like toolbars. In addition, palettes can be docked onto other palettes to 
create palette groups. Drag a palette onto the desktop by its named tab (the tab that contains the 
name of the palette. The palette must actually be displayed before it can be dragged onto another 
palette group. To dock a palette to any of the four edges of the TurboCAD window, drag the 
palette toolbar to the relevant arrow, either displayed at the center of the drawing area, or along 
the desired edge. 

Note: These arrows are displayed only if Docking Stickers is checked on the Palettes page of 
the Customize window (Tools / Customize). 
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To combine palettes into a group, drag more palettes onto a docked palette. 
  
To replace palettes, simply drag their tabs back to the palette area. 

 

Drafting Palette-Creating Standard Views 

The Drafting Palette enables you to insert standard views of your model into Paper Space. 

 

Environments Palette 

Provides easy and fast access to environments 
Categories 

 

Set the Environment category. 
Find Environment  
To switch the environment display from thumbnails to list format, click View Thumbnails and 
select a different view. 

  

 
TurboCAD has LightWorks rendering engine available by default. The Render Engine Filter 
allows you to specify which components will be displayed in the palette. ALL sets the palette to 
show all elements from all installed rendering engines. LW will show only LightWorks elements. 

Search Option: 

You can also search a environment in the palette. Type a word in "find" option to search, the first 
suitable item is highlighted. To browse through the environments, buttons next to the input field 
highlight and can be used to show the previous or next suitable item.  

 

Library Palette 

The TurboCAD library is where you can access symbols and parts. Symbols and parts, like blocks 
and groups, are objects available for repeated use. But while groups and blocks are internal to a 
drawing, library items are external files. Generally, each symbol or part is stored as a file, and 
libraries of files are stored in specified library folders. Any Windows folder can be recognized as a 
library folder, and any vector drawing file (not just TurboCAD files) can be used as a symbol. 

 
A symbol or part is placed into a drawing as a group; it has a unique name and is selected and 
manipulated as a single object. Because they are placed as groups, each instance of a part or 
symbol creates additional drawing data, and inserting numerous library items can increase your 
drawing size significantly. 
TurboCAD provides several symbols and parts, organized in folders by category. Each symbol is 
a separate *.tcw file, and parts are *.ppm files. These files are installed, by default, to the 
"Symbols" folder in the TurboCAD installation folder. 
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You can modify these symbols (though it is preferable to modify copies and leave the originals 
intact), and also create and save your own symbols. Symbol manipulation is done via the Library 
Palette. 

 

 

Luminances Palette 

Provides easy and fast access to object luminance. 
Categories 

 

 

Specify the luminance category. 
Find Luminance. 
 

To edit a luminance, select the item in the palette, then right-click and select Edit Luminance. Or 
double-right-click on the item, or click Edit Luminance. 

To switch the luminance display from thumbnails to list format, click View Thumbnails and 
select a different view. 
 
Right-click on the Luminance palette will open a local menu that provides a wide array of 
options. 

 

MacroRecorder Palette 

Creates and plays scripts - scenarios of creating and editing objects and manipulating their 
properties. You can also record object transformation - moving, copying, scaling, and rotating. 
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Scripts can be saved for future play.  

Materials Palette 

Provides easy and fast access to object materials. 

All materials that have been defined are displayed here, and can be assigned to objects and 
edited. 
Find Material of Selection. 

To edit a material, select the item in the palette, then right-click and select Edit Material. Or 
double-right-click on the item, or click Edit Material. 

You can use Select by material to select the object by applied material. Select the material in the 
materials palette and click Select by material the object having the material applied will be 
selected. Make sure that Active Drawing is selected in the categories. 

To switch the luminance display from thumbnails to list format, click View Thumbnails and 
select a different view. 
 
TurboCAD has Lightworks rendering engine available. The Render Engine Filter allows you to 
specify which components will be displayed in the palette. ALL sets the palette to show all 
elements from all installed rendering engines. LW will show only LightWorks elements. 

Dragging and Dropping Materials 

Another way to apply materials to object is to select a material in the Material palette, then drag-
and-drop it onto the desired object. 

Drag on Facet 

Selecting the Drag on facet setting in the local menu of the Material palette will allow you to drag 
a material to a single facet of an object. 
 

 
Measurement Info 

Displays measurements calculated by the Measure tools. You can measure point coordinates, 
distance and perimeter, angle, and area.  

Other than creating a parametric part from within TurboCAD, the other way to create a part is to 
write a script. The parts provided in folders such as "Cabinet" are created this way.  
If you want to write your own script, or edit an existing script, you can use the Parametric Part 
Script Editor. 

1. To load an existing script into the editor, click Open. 

 

2. Locate one of the scripts in the "Cabinet" folder. 
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3. The script appears in the editor. 

 

Selection Info Palette 

Selection Info- Properties 

This example consists of a rectangle, a circle, and a linear dimension. 

 
Open the Selection Info palette to see the three objects listed. 

 

  

Tip: The number of selected objects must be less than or equal to Maximum Selection Info 

Entities, which is set in the Program Defaults page of the TC Explorer Palette. 
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In the Selection Info toolbar, click Highlighting, and make sure Polyline is selected. 

This highlights the rectangle in the drawing window. 

Conversely, if you select objects in the drawing area, they will be highlighted in the Selection Info 
palette. 

You can use this palette to change an object's properties. Highlight the circle, and the lower 
section of the palette contains the categories of properties for the circle. In this example, the color 
and line weight were changed in the Pen category. 
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Note: For 3D ACIS objects, physical properties are not automatically listed. Click 
the Physical Metrics icon in the palette toolbar if you want to see engineering properties (volume, 
moments of inertia, etc.). 

The new properties appear in the drawing area. (You may have to turn off the Highlight icon in 
the toolbar to see the changes.) 

 
To make some changes to the circle, click Select. 

 
Move one or more nodes to change the shape. 

The changed dimension appears in the drawing area. 
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Note: You can also edit an object's properties by clicking the Properties icon in the palette toolbar. 
This opens the Properties window for the object. 

  

 
The Copy icon is used to view an object's properties in HTML format They will appear in your 
default browser. The HTML file is stored in the ...Profiles/Built-in folder. 

  
To set options for the Selection Info palette, click Options. 
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The options at the top control highlighting and fading for objects that are not being edited. To set 
a filter for what objects are displayed in the palette, click New. This options the Selection by 

Query window; in which you can specify types of objects you want to display. In this example, all 
objects that are either black or dimensions will be displayed in the palette. 

  

   

1. Each filter must be assigned a name. 

 

2. To apply this filter, click Filter in the toolbar. 
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3. Select the filter you just created. 

 

Now only the polyline and dimension appear in the palette. 

4. You can change geometry by modifying geometry in the Metrics category. Open Metrics for 
the Polyline - the coordinates for each vertex are listed. 

 

5. Open the branch for a vertex to see its X and Y coordinates. These values can be changed. 
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The vertex highlighted in the palette is also highlighted in the drawing area. 

 

Some values cannot be edited, such as Area and Perimeter. These values depend on the 
coordinates of the vertices, and are grayed out 

.  
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6. To see options for another type of object, create several objects and group them (select them, 
then select Format / Create Group). 

 

The Extents Size parameter has been added to the selection Info palette properties.  Extents Size 
parameter also works with groups, blocks and insertions. You can use the ‘Extents size’ property 
to select entity according to size valuation. Select objects that you think are big or small, or object 
in any range you want. 

You can also select objects on the basis of extents size parameter using Select by Query. 

1. This object is a "Group of Graphics," and you can open it to see each object that comprises the 
group. To edit the group, click Edit Content. 

 

2. The group's contents fill the screen. Make some change, such as adding or removing objects 
from it. 

 

3. When finished, click Finish Edit Content. 
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Selection Info- Constraints 

The Constraints tab of the Selection Info palette shows what constraints have been applied, and to 
which objects they are applied.  
This example consists of two lines and two circles. Three constraints were applied: the two lines 
are constrained to be parallel; the circles are constrained to be concentric, and a tangent constraint 
was applied to the outer circle and adjacent line. 

1. Make sure the All icon is disabled at the top of the Selection Info palette. Select the outer line,
which only has one constraint (parallel). In the Constraints tab, the PARALLEL constraint is
listed, below which are listed the two lines to which the constraint applies.

2. Move the cursor over the PARALLEL constraint in the Constraints tab, and the two lines that
have this constraint are highlighted.
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3. Move the cursor over either line below PARALLEL. The relevant line is highlighted. 

 

4. Now select the inner line, which has two constraints applied to it. These two constraints are 
listed: PARALLEL and TANGENT. 

 

5. Now click All. The four objects (two lines, two circles) are listed, along with several block 
marks. These are the constraint markers themselves, which can be selected and deleted if you 
want to remove the constraint. In the Constraints tab, two items are listed for each constraint - 
one for each of the constrained objects. 

 

6. Select any blockmark in the palette to see it highlighted onscreen (Highlighting must be 
enabled). 
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Audit System: 

“Audit” is added to menu “Filters”. Audit System is used to detect a ‘bad’ object in drawing. A 
‘bad’ object triggers at least one audit conditions. 

 

Audit Report: 

We can also generate an audit report by clicking on audit report icon on menu bar of selection 
info palette. 

         "Audit" report (HTML page). 

Audit Options: 

Audit icons which are shown in selection info palette with objects can be enabled or disabled by 
Selection Info Palette Options dialogue box. To open Selection Info Palette Options dialogue box 
select options icon from selection info menu bar. 
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Select "Options..." from Selection Info Palette Options. 

“Audit” section 

The Style Manager Palette 

The Style Manager enables you to define styles for the following commonly-used objects: 

• Text

• Profiles (for modifying windows and doors)

• Windows

• Doors

• Walls

• Schedules

• Slabs

• AEC Dimensions

• Dimensions

• Stairs

• Rails

• Tables

You select assign a style to an object through the object properties on the General page. Simply 
select the style in the Style drop-down box at the bottom of the page. You can open the Style 
Manager by selecting Tools / Palettes / Style Manager Palette. 
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Each category in the Style Manager contains one pre-defined style, called "Standard." For each of 
these styles, you can define relevant properties. 

To create a new style, highlight a style you want to base the new style on, and click Create New 

Style. 

Once you have new style, there are icons at the top you can use to Rename or Delete it. 
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The Delay Style Modification* icon can be enabled if you don't want to update your style with 
each property change. 

 

If Delay Style Modification is enabled, you can view both old and new properties in the lower 
pane. At the top is an icon for updating the entire style at once, or for clearing changes not yet 
implemented. 

 

 

 

 

The TC Explorer Palette 

This palette enables you to perform many operations in one place. It serves as a file browser with 
previews, and displays components and editable parameters for all open drawings. 

 

Event Viewer 

The Event Viewer palette creates a log detailing Error and Warning events effectively improving 
access to the TurboCAD diagnostic information. 

Local menu 

• Clear – clears all events 

• Write to Log File – turns on/off the recording to the log file. 

• Open Log File – opens the log file in a text editor. 
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Level 

The icon shown under the 'Level' field can have 3 colors with the values: YELLOW = 
Warning, RED = Critical, and GREEN = Info 
If the 'Show' parameter of a warning dialog is set to 'Off', the icon in the Event Viewer will be 
displayed with a strikethrough X.  
 

Image Manager Palette 

Enables you to manipulate all the raster images in the current drawing. You can insert files 
directly from this window using From Image List. You can also select Multiple files by using 
"New" button and importing multiple images in the Image Manager palette.  

 

 

Insert 
Insert a new image by drag and drop. 

 

 
Use the PPI (pixel per inch) option or the Width/Height options from the Inspector bar to set the 
size of the image. 
The PPI image property is also available from the Selection Info Palette 
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The toolbar at the top of the window can be used to change the image list as thumbnails, list, or 
detailed list. 

 
GeoMarks and TAP files 

The Geomarks palette allow you to open TAP file created in IMSI/Design TurboApps products. 

 

 

 
*To open a TAP file:* 

1. Open the GeoMarks palette. 

2. Click the Browse button. 

3. Browse to the file you wish to open. 

 

4. Select the file and click Open. 
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5. The contents of the TAP must be unpacked. Select a folder to unpack the TAP content, or click 
Make New Folder to create a new folder, or press Cancel to use a temporary folder. 

 

 
You can click on any link to view its content. 

 



180 

TurboCAD for AutoCAD 
Users 

 

 

 
The controls are explained below: 

If a TAP file has been created in TurboApps with markups, then TurboCAD now has the ability to 
display these mark-ups when a TAP file is imported and opened into the program. 
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AutoCAD: Palettes 
Properties Palette 

PROPERTIES (Command)  Find 

When more than one object is selected, only those properties common to all selected objects are 
displayed. When no objects are selected, only the current settings of general properties are 
displayed. 

You can specify a new value to modify any property that can be changed. Click the value and use 
one of the following methods: 

• Enter a new value.

• Click the down arrow at the right and select a value from the list.

• Click the Pick Point button to use the pointing device to change a coordinate value.

• Click the QuickCalc calculator button to calculate a new value.

• Click the left or right arrow to increase or decrease the value.

• Click the […] button and change the property value in a dialog box.
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Layer Properties Manager 

You can add, delete, and rename layers, change their properties, set property overrides in 
layout viewports, and add layer descriptions. 

LAYER (Command)  Find 

 

Layers and Layer Properties 

New Layer  

Creates a layer with a default name that you can immediately change. The new layer inherits the 
properties of the currently selected layer in the layer list. 

New Layer Frozen VP In All Viewports  

Creates a layer and freezes it in all existing layout viewports. This button is accessible from the 
Model tab or layout tabs. 

Delete Layer  

Deletes selected layers. The following layers cannot be deleted: 

• Layers 0 and Defpoints 

https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_CCF51CF06C2745199FF1F304C657A0C9
https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_6129559FEB4B47F1A528219564C6A630
https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_6129559FEB4B47F1A528219564C6A630
https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_17CA31DFAF4640B9B1B44F97714F0C0D
https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_86DAE224938944388991D9156D177100
https://help.autodesk.com/view/ACD/2019/ENU/?guid=GUID-B297EBD9-D68C-47E1-87CE-1B3798496599#GUID-B297EBD9-D68C-47E1-87CE-1B3798496599__SECTION_1FDD8793193342F79E1383B401FE13AA
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• Layers containing objects, including objects in block definitions

• The current layer

• Layers used in an external reference

• Layers in a partially opened drawing (Not applicable to AutoCAD LT.)

Note: Be careful about deleting layers if you are working on a drawing in a shared project or one 
based on a set of layering standards. 

Set Current 

Sets the selected layer as the current layer. New objects are automatically created on the current 
layer. (CLAYER system variable). 

Tools Palette 

Tool palettes are used to organize tools that range from blocks to commands to hatch patterns, 
and are displayed as part of the Tool Palettes window (TOOLPALETTES command). 

You customize tool palettes by dragging and dropping files from Windows Explorer or File 
Explorer, objects from the drawing area, contextual menus of the Tool Palettes window, 
Customize User Interface (CUI) Editor, or Customize dialog box. Each tool palette that is created 
represents a tab on the Tool Palettes window. 

QuickCalc Calculator 

Performs a full range of mathematical, scientific, and geometric calculations, creates and uses 
variables, and converts units of measurement. 

External References Palette 

Opens the External References palette. 

Note: The FILEDIA system variable is ignored when you attach files from the External References 
palette. 

Sheet Set Manager 

Displays and organizes named collections of drawing sheets 

SHEETSET (Command) 

The Sheet Set Manager is not fully functional if: 

• The command is active;

• No drawing is open;
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• The sheet set is locked by another user; or 

• A lock icon displayed in front of the sheet set name in the Sheet Set Manager indicates that 
the sheet set is locked. Hold your cursor over the lock icon to view a tooltip that shows who 
has the sheet set locked. 

 

Markup Set Manager 
 
Displays information about loaded markup sets and their status. 

You can show or hide markups and their originating drawing files in your drawing area. You 
can change the status of individual markups and add notes and comments to them. 

 

DesignCenter 

Organizes access to drawings, blocks, hatches, and other drawing content. 

With DesignCenter, you can 

• Browse for drawing content such as drawings or symbol libraries on your computer, on a 
networked drive, and on a web page 

• View definition tables for blocks and layers in any drawing file and then insert, attach, or 
copy and paste the definitions into the current drawing 

• Update (redefine) a block definition 

• Create shortcuts to drawings, folders, and Internet locations that you access frequently 

• Add content such as xrefs, blocks, and hatches to a drawing 

• Open drawing files in a new window 

• Drag drawings, blocks, and hatches to a tool palette for convenient access 

• Copy and paste content, such as layer definitions, layouts, and text styles between open 
drawings 
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Materials Browser 
The Materials Browser allows you to navigate and manage materials. 
 

 
Manage material libraries provided by Autodesk, or create custom libraries for specific projects. 
Use the filter buttons to change which materials are displayed, the size of the thumbnails, and the 
amount of displayed information. 
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Edits the material selected in the Materials Browser. 

The configuration of the Materials Editor changes depending on the type of material that is 
selected. 
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Visual Styles Manager 
 
Creates and modifies visual styles. 
The Visual Styles Manager has a panel of sample images of the visual styles available in the 
drawing, and the following properties panels: 

• Face settings 

• Environment settings 

• Edge settings 

• Lighting settings 
 

Note: Changes that you make in the Visual Style panel on the ribbon create a temporary visual 
style, *Current, * that is applied to the current viewport. The settings are not saved as a named 
visual style. 
 

Render Presets Manager 
Controls all the primary settings for rendering. 
 

 
 

You use the Render Presets Manager to specify the primary settings to use when rendering. You 
can also use the controls located on the ribbon to change some general rendering settings or set a 
named render preset current. 
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TurboCAD: Drawing Aids 
Construction Geometry 
Construction geometry tools enable you to place temporary lines and circles in your model. 
Construction geometry are not drawing objects; they are used as references. 

 

Snaps can be used on construction geometry for creating model geometry, as well as other 
construction geometry. However, because construction lines are infinite, 
the Vertex and Middle Point snaps are not available. You can display the Construction toolbar 
by right-clicking in any toolbar area and selecting Construction.  

 

 

 
These tools are also available on the fly-out toolbar from the Drawing Tools. 

Note: You can use construction entities with the Trim tool to trim other drawing entities, however 
you cannot trim construction entities themselves. 

 

Clearing and Hiding Constructions 

Default UI Menu: Edit / Clear / Construction, Edit / Clear / All Constructions  

You can clear construction objects via the Edit menu. 
Edit / Clear / Construction enables you to delete a single construction object. 
Edit / Clear / All Constructions deletes all construction geometry. 
To hide constructions, you can hide the $CONSTRUCTION layer. Open the Layers window and 
uncheck the visibility box for this layer. 

 

Construction Geometry Properties 

Construction objects are placed on layer "$CONSTRUCTION". By default, the layer color is light 
blue, and the line style is dash-dot. You can change construction geometry color and line styles 
via the layer manager. 
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TurboCAD: Drawing Compare 
Drawing Compare is an easy to use utility which allows you to compare two drawings and find 
the differences between them. You can use 2CD, DWG, TCW, and BMP files. 
The process is simple, just load two drawings and press the Compare button. The Vector 
drawing files are converted to a raster image map and pixel testing detects changes between the 
two images. 
 

Comparing Drawings 
Comparing drawings is a simple process: 
1. Use the Select File 1 button or path to specify the first file for comparison. 
2. Use the Select File 2 button or path to specify the second file for comparison. 
3. Press the Compare button. 
4. If there are differences between the two drawings you will see the following message: 
5.  

 
 

1. Press the OK button. Your Drawings will now be loaded for comparison 
2. Use the Zoom and Show buttons to examine your files and the differences. 

 
Drawing Compare File Types 
TCW: (TurboCAD Native Files): You can use any TCW file from v4 through v24. 
DWG: (AutoCAD Native Files): You can use any DWG file from version R13 to version 2019. 
BMP: You can use any standard Windows BMP file. However, both BMP files must be the same 
size. If the images are of different sizes you will get an error message. 
 

 
 
PNG: You can use any standard Windows PNG file. However, both PNG files must be the same 
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JPG: You can use any standard Windows JPG file. However, both JPG files must be the same 
size. If the images are of different sizes you will get an error message. 
PDF: Adobe Portable Document Format 
SKP: SketchUp file format. 

Show & Compare buttons

 Show First File: Shows only the first file. 

 Show Second File: Shows only the second file. 

 Show the Differences: Shows only the differences between the two files. 

 Blink Differences: Blinks between the two files to illustrate the changes. 

 Compare: Compares the two files and generates the difference images. 
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AutoCAD: Drawing Compare 
The COMPARE command provides you with a visual comparison between different revisions of 
a drawing or different drawing, and then review those changes. During the comparison process, 
it identifies objects that have been modified, added, or removed in the review drawing. The 
default two-color comparison mode uses green and red to highlight the differences.  

The DWG 1 and DWG 2 are inserted as blocks into the comparison drawing. In the comparison 
drawing, the differences are highlighted, as change sets, using revision clouds. Revision clouds 
are created on a new layer, in the comparison drawing, named 0-Markups.  

The number of differences in the two drawing files determines the number of revision clouds. By 
default, rectangular revision clouds are used to highlight the differences. You can use these 
various comparison options for reviewing the comparison drawing: 

View – You can change the display order and object visibility in the comparison drawing from 
the compare ribbon contextual tab. 

Filter – You can use the text and hatch filters to show or hide these objects in the comparison 
drawing. By default, text objects are always included in the drawing comparison. 

Change set – You can change the type of revision cloud for your change set, control the offset 
distance between the bounding box to the rectangle used for creating the revision cloud, and 
navigate through the various change sets in the comparison drawing. 
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Summary of AutoCAD Keyboard Shortcuts 

Function Keys 
 

AutoCAD Function Keys Meaning in AutoCAD Meaning in TurboCAD 

 
F1 Displays online help Displays online help 

F2 Toggles text-graphics windows Shows Calculator palette 

F3 Toggles osnap mode Toggles palette 

F4 Toggles tablet mode Selects rectangular area for aerial view 

F5 Cycles through isoplanes Redraws active view 

F6 Toggles dynamic UCS Selects next object in draw order 

F7 Toggles grid display Selects next object in back order 

F8 Toggles ortho mode ... 

F9 Toggles snap mode ... 

F10 Toggles polar tracking ... 

F11 Toggles osnap tracking ... 

F12 Toggles dynamic input ... 

Ctrl+F4 Closes drawing Closes drawing 

Ctrl+F6 Switches to next drawing window Switches to next drawing window 

Alt+F4 Closes AutoCAD Closes TurboCAD 

Alt+F8 Runs VBA macros ... 

Alt+F11 Opens VBA IDE window ... 

 

 

Other Keys  

AutoCAD Other Keys Meaning in AutoCAD Meaning in TurboCAD 

Ctrl Overrides Lock UI ... 

 Selects 3D faces  
 Cycles through selection  
Del Deletes objects Erases selected objects 

Enter Executes commands Executes coordinate values 

 Accepts options  
 Repeats last commands  
Esc Cancels current command Cancels command in progress 

 Cancels grips  
Shift 

 
 
 

Overrides ortho mode Enforces ortho mode 



193 

Lesson 6  Advanced TurboCAD Tools 
 

 

 

Control Keys   

AutoCAD Control Keys Meaning AutoCAD Meaning in TurboCAD 

Ctrl+A Selects all objects Selects all objects 

Ctrl+B Toggles snap mode ... 

Ctrl+C Copies to Clipboard Copies to Clipboard 

Ctrl+D Toggles dynamic UCS Places camera at drawing center 

Ctrl+E Cycles isoplanes Sets input focus to Edit bar 

Ctrl+G Toggles grid display Starts editing group content 

Ctrl+H Toggles pick style Selects hyperlink 

Ctrl+K Displays Hyperlinks dialog Selects objects by color 

Ctrl+L Toggles ortho mode Selects all objects on current layer 

Ctrl+N Starts new drawing Starts new drawing 

Ctrl+O Opens file Opens file 

Ctrl+P Displays Plot dialog Prints drawing 

Ctrl+Q Toggles log file Selects objects by query 

Ctrl+R Cycles to next viewport Sets focus to status bar 

Ctrl+S Saves drawing Saves drawing 

Ctrl+T Toggles tablet mode Selects objects by type 

Ctrl+U Toggles polar tracking Toggles world coordinate system 

Ctrl+V Pastes from Clipboard Pastes from Clipboard 

Ctrl+X Cuts to Clipboard Cuts to Clipboard 

Ctrl+Y Redoes last command Redoes last command 

Ctrl+Z Undoes last command Undoes last command 

Ctrl+Shift+A Toggles group mode ... 

Ctrl+Shift+C Copies with basepoint Toggles Color palette 

Ctrl+Shift+S Displays Save As dialog Toggles symbols palette 

Ctrl+Shift+V Pastes with insertion point Sets workplane as active view 

Ctrl+1 Toggles Properties palette ... 

Ctrl+2 Toggles DesignCenter palette ... 

Ctrl+3 Toggles Tools palette ... 

Ctrl+4 Toggles Sheetset Manager ... 

Ctrl+5 Toggles Info palette ... 

Ctrl+6 Toggles dbConnect Manager ... 

Ctrl+7 Toggles Markup Set Manager ... 

Ctrl+8 Toggles QuickCalc palette ... 

Ctrl+9 Toggles command line ... 

Ctrl+0 Toggles Cleanscreen mode ... 



194 

TurboCAD for AutoCAD 
Users

Shift Keys 

AutoCAD Shift Keys Meaning in AutoCAD Meaning in TurboCAD 

Shift+A Overrides osnap Displays absolute coordinates 

Shift+C Overrides CENter osnap Snaps to center of arc 

Shift+D Overrides snap & tracking Relocates reference point 

Shift+E Overrides ENDpoint osnap Relocates reference point 

Shift+G ... Snaps to grid 

Shift+H ... Snaps opposite 

Shift+I ... Snaps to intersections 

Shift+L Overrides snap & tracking Relocates origin 

Shift+M Overrides MIDpoint osnap Snaps to midpoint 

Shift+N ... Snaps to nearest 

Shift+O ... Snaps ortho 

Shift+P Overrides ENDpoint osnap Displays polar coordinates 

Shift+Q ... Snaps to quadrant 

Shift+R ... Displays relative coordinates 

Shift+S Enforces osnap modes Turns object snap off 

Shift+V Overrides MIDpoint osnap Snaps to vertex 

Shift+W ... Shows magnetic point 

Shift+X Overrides polar mode Locks x-coordinate (.xz point filter) 

Shift+Y ... Locks y-coordinate (.yz point filter) 

Shift+; Enforces osnap modes ... 

Shift+, Overrides CENter osnap ... 

Shift+’ Overrides osnap ... 
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Summary of TurboCAD Keyboard Shortcuts 

Function Keys 

TurboCAD Function Keys Meaning 

F1 Shows online help 

F2 Shows Calculator palette 

F3 Toggles palette 

F4 Selects a rectangular area to create the aerial view 

F5 Redraws the active view 

F6 Selects the next object in draw order 

F7 Selects next object in back order 

Shift+F1 Displays help for clicked buttons, menus and windows 

Shift+F6 Selects the next object in draw order and adds to current selection 

Shift+F7 Selects next object in reverse order and adds to current selection 

Ctrl+F2 Hides Color palette 

Ctrl+F6 Selects the next object in draw order for node editing 

Ctrl+F7 Selects the next object in reverse order for node editing 

Alt Keys 

TurboCAD Alt-keys Meaning 

Alt+G Shows or hides the grid 

Alt+Shift+A Shows or hides the aperture circle 

Alt+Shift+B Creates a transferable block from the selection 

Alt+Shift+C Shows or hides the crosshair cursor 

Alt+Shift+E Breaks up a graphic into its constituent parts 

Alt+Shift+F Sets workplane by facet 

Alt+Shift+G Groups the selected entities into a single entity 

Alt+Shift+I Shows or hides the isometric cursor 

Alt+Shift+R Creates regions from the selected entities 

Alt+Shift+W Places on workplane 

Alt+Shift+X Defines a file as an external reference for the drawing 

Alt+Shift+3 Draws workplane using three points 
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Control Keys 

TurboCAD Ctrl-keys Meaning 

Ctrl+A Selects the entire drawing 

Ctrl+C Copies the selection and puts it on the Clipboard 

Ctrl+D Places camera to the drawing center 

Ctrl+E Sets input focus to edit bar 

Ctrl+F Opens the Properties dialog for the selected entity or tool 

Ctrl+G Starts to edit group content 

Ctrl+H Picks hyperlink 

Ctrl+I Selects all entities with a specific info string 

Ctrl+K Selects all entities with a specific color 

Ctrl+L Selects all entities on the active layer 

Ctrl+M Selects all blocks and groups with a specific name 

Ctrl+N Creates new drawings 

Ctrl+O Opens existing drawings 

Ctrl+P Prints active drawings 

Ctrl+Q Selects all entities with a query 

Ctrl+R Sets input focus to status bar 

Ctrl+S Saves the active drawing 

Ctrl+T Selects all entities of specific type 

Ctrl+U Shows or hides the world coordinate system 

Ctrl+V Inserts the Clipboard contents 

Ctrl+W Sets plan view of the World User Coordinate System 

Ctrl+X Cuts the selection and puts it on the Clipboard 

Ctrl+Y Redoes the previously undone action 

Ctrl+Z Undoes the last action 

Ctrl+Alt+A Inserts the result of the Boolean addition of two solid objects 

Ctrl+Alt+B Blends the edges of a 3D entity 

Ctrl+Alt+C Sets camera parameters 

Ctrl+Alt+D Creates a shaded image of 3D wireframe 

Ctrl+Alt+G Sets the WorkPlane to that of an entity 

Ctrl+Alt+H Regenerates a 3D model with hidden lines suppressed 

Ctrl+Alt+I Inserts the result of the Boolean intersection of two solid objects 

Ctrl+Alt+L Slices a 3D entity by a plane 

Ctrl+Alt+M Switches to Model Space 

Ctrl+Alt+O Views/customizes the drawing display settings 

Ctrl+Alt+P Centers the view around defined point 

Ctrl+Alt+Q Creates a realistically shaded image of 3D wireframe 

Ctrl+Alt+S Inserts the result of the Boolean subtraction of two solid objects 

Ctrl+Alt+W Sets WorkPlane by world coordinate system (WCS) 

Ctrl+Shift+B Shows or hides the blocks palette 
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Ctrl+Shift+C Shows or hides Color palette 

Ctrl+Shift+D Sets point of interest to the drawing center 

Ctrl+Shift+G Finishes editing the group content 

Ctrl+Shift+H Hatches an object or area 

Ctrl+Shift+I Shows or hides the selection info 

Ctrl+Shift+N Shows or hides Internet palette 

Ctrl+Shift+O Views/customizes the program settings. 

Ctrl+Shift+P Copies properties from one object to another 

Ctrl+Shift+R Relocates the block reference point 

Ctrl+Shift+S Shows or hides the symbols palette 

Ctrl+Shift+T Shows or hides the measurement info 

Ctrl+Shift+U Shows or hides the user coordinate system 

Ctrl+Shift+Up Aligns the selected entities to the top of the selection window 

Ctrl+Shift+V Sets workplane by the active view 

Ctrl+Shift+W Sets plan view of the current User Coordinate System 

Numeric Keypad 

TuboCAD Numeric Keypad Meaning 

Num 2 Moves cursor one step down 

Num 4 Moves cursor one step left 

Num 6 Moves cursor one step right 

Num 8 Moves cursor one step up 

Num - Zooms out one step about the cursor position 

Num * Sets uniform zoom for all views 

Num + Zooms in one step about the cursor position 

Other Keys 

TurboCAD Other Keys Meaning 

Space Selects objects for editing 

Tab Sets input focus to edit bar 

Delete Erases the selection 

Esc Cancels the current procedure 

Shift+Tab Sets input focus to status bar 

Shift+Back Fits the page(s) in the window 

Alt+Back Inserts all selected elements as large as possible 

Ctrl+Back Inserts all elements as large as possible 

Ctrl+Shift+Back Selects a rectangular area to fill the window 
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Keyboard 

TurboCAD Keyboard Meaning 
 

A Sets absolute coordinates 

C Sets single snap to the center of a planar object 

D Sets single snap to the divide point of a line or arc 

E Sets single snap to the center of a 3D object 

G Sets single snap to the nearest grid point 

H Sets single snap to the opposite point 

I Sets single snap to the intersection of two objects 

J Sets single snap to the projection point 

L Relocates relative/polar origin 

M Sets single snap to the midpoint of a line 

N Sets single snap to the nearest point 

O Relocates last point by next click 

P Sets polar coordinates 

Q Sets single snap to the quadrant point of an arc 

R Sets relative coordinates 

S Sets no snap at all, get the mouse position (click) 

V Sets single snap to the nearest vertex 

W Assigns a name to workplane or sets a named workplane 

X Locks X position 

Y Locks Y position 

Z Locks Z position 

Shift+A Sets absolute coordinates 

Shift+C Sets snap to the center of a planar object 

Shift+D Sets snap to the division point of a line or arc 

Shift+E Sets snap to the center of a 3D object 

Shift+G Sets snap to the nearest grid point 

Shift+I Sets snap to the intersection of two objects 

Shift+K Provides snap extension apparent intersection lines 

Shift+L Relocates relative/polar origin 

Shift+M Sets snap to the midpoint of a line 

Shift+N Sets snap to the point on the nearest entity 

Shift+O Sets snap to the ortho angle 

Shift+P Sets polar coordinates 

Shift+Q Sets snap to the quadrant point of an arc 

Shift+R Sets relative coordinates 

Shift+S Sets no snap at all, get the mouse position 

Shift+T Sets snap tangent to an arc and curve 

Shift+V Sets snap to the nearest vertex 

Shift+W Shows the point on which the next snap works 

Shift+X Provides snap extension orthogonal lines 
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Cursor Pad 

TurboCAD Cursor Pad Meaning 
 

Up Scrolls view up 

Down Scrolls view down 

Left Scrolls view left 

Right Scrolls view right 

Home Scrolls view home 

 
Shift+Up Rotates camera left 

Shift+Down Rotates camera right 

Shift+Left Rotates camera left 

Shift+Right Rotates camera right 

Shift+Page Up Brings the selected entity(s) in front of others 

Shift+Page Down Sends the selected entity(s) behind others 

 
Alt+Up Sets top View 

Alt+Down Sets bottom View 

Alt+Left Sets left View 

Alt+Right Sets right View 

Alt+Page Up Sets SW isometric View 

Alt+Page Down Sets SE isometric View 

Alt+Home Sets front view 

Alt+End Sets back view 

Alt+Shift+Page Down Sets NW isometric view 

Alt+Shift+Page Up Sets NE isometric view 

Ctrl+Left Turns camera left 

Ctrl+Right Turns camera right 

Ctrl+Up Turns camera up 

Ctrl+Down Turns camera down 

Ctrl+End Pans the window to the selected point 

Ctrl+Shift+Down Aligns the selected entities to the bottom of the selection window 

Ctrl+Shift+Right Aligns the selected entities to the right of the selection window 

Ctrl+Shift+Left Aligns the selected entities to the left of the selection window 

Ctrl+Shift+Home Aligns the selected entities to the middle of the selection window 

Ctrl+Shift+End Aligns the selected entities to the center of the selection window 
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Appendix  

TurboCAD-AutoCAD Dictionary 
Understanding TurboCAD Jargon 

 
 
 
 

When a TurboCAD user says... ...in AutoCAD, it means: 
 

 
A 

Active Current 

Add Union 

Assemble Align 

Attribute  Similar to extended entity data; TurboCAD can also attach AutoCAD-like attributes 

to blocks 

B 

Basepoint Origin 

Blend Fillet on 3D objects 

Block Same as a block in AutoCAD; TurboCAD also uses symbols 

Brush Pattern The pattern that fills an area; TurboCAD has fills and hatches 
 

C 

Camera View or viewpoint 

Construction line Xline; TurboCAD does not have rays 
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When a TurboCAD user says... ...in AutoCAD, it means: 
 

 

D 

Datum DimOrdinate 

Dot Point 

Double Point 2P option, as in circles 
 

E 

Edit bar Direct distance entry 

Editable layer Unlocked layer 

Entity Object 
 

F 

Format painter MatchProp 

Fit array Array 
 

H 

Hatch Vector hatching pattern, as in AutoCAD; creates independent hatch objects 

Hemisphere Dome 
 

I 

Inspector bar Dynamic input 
 

L 

Line style Linetype 

Local menu Cursor menu 

Locked coordinates Point filters 
 

M 

Magnetic point AutoSnap magnet 

Major grid Grid 

Minor grid Subdivision of the grid 

Multiline Multi-segment line, like using Line command repeatedly 
 

N 

Node Handle 

Not visible layer Off, frozen layer 
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Appendix TurboCAD-AutoCAD Dictionary 

 

When a TurboCAD user says... ...in AutoCAD, it means: 
 

 

O 

Order Draw order 
 

P 

Paper Layout 

Path Hatching Hatching applied to an area defined by a series of picked points 

Pen Color, width, and style of lines 

Pen style Linetype 

Polyline Multi-segment line (old usage); polyline (new usage) 

Properties toolbar Object Properties toolbar 
 

R 

Read-only layer Locked layer 

Rubber stamp Copy multiple 
 

S 

SEKE Alias 

Snap mode Object snap mode 

Split Break 

Style  Predefines properties for objects; whereas in AutoCAD, properties are predefined for a 

limited number of objects (such as text, multilines, and tables), TurboCAD can create 

named styles for any type of object 

Sky light Sun light 

Symbol Unlike blocks (which are referenced), symbols are copied 
 

T 

TC Explorer DesignCenter 

Three Point Circle Circle 3P command 

Tools palette Dashboard 
 

U 

Unblock/Explode Explode 
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When a TurboCAD user says... ...in AutoCAD, it means: 

V 

Vector pan Pan 

Vector By distance and angle 

Visible layer On, thawed layer 

W 

Worldplan WCS 

Workplane UCS 

Workspace Model space 
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